## Contents

### Preface

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
</tr>
</tbody>
</table>

### Getting Started

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>1</td>
</tr>
<tr>
<td>Signing In and Getting Started</td>
<td>1</td>
</tr>
<tr>
<td>Exploring Work Areas</td>
<td>6</td>
</tr>
<tr>
<td>Performing General Tasks in Your Application: Overview</td>
<td>8</td>
</tr>
<tr>
<td>FAQs for Getting Started</td>
<td>9</td>
</tr>
</tbody>
</table>

### Search

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's the difference between the various searches on the page?</td>
<td>13</td>
</tr>
<tr>
<td>Global Search</td>
<td>13</td>
</tr>
<tr>
<td>Searches on the Page</td>
<td>15</td>
</tr>
</tbody>
</table>

### Watchlist

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watchlist: Overview</td>
<td>21</td>
</tr>
<tr>
<td>Creating Watchlist Items: Procedure</td>
<td>21</td>
</tr>
<tr>
<td>Displaying and Hiding Watchlist Items: Procedure</td>
<td>21</td>
</tr>
<tr>
<td>FAQs for Watchlist</td>
<td>22</td>
</tr>
</tbody>
</table>

### Notifications and Approvals

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Tasks: Overview</td>
<td>25</td>
</tr>
<tr>
<td>Actions and Statuses for Workflow Tasks: Explained</td>
<td>25</td>
</tr>
<tr>
<td>Viewing and Acting On Notifications: Procedure</td>
<td>27</td>
</tr>
<tr>
<td>Using Your Worklist for Workflow Tasks: Procedure</td>
<td>28</td>
</tr>
<tr>
<td>Defining a Vacation Rule for Workflow Assignments: Explained</td>
<td>29</td>
</tr>
<tr>
<td>FAQs for Notifications and Approvals</td>
<td>31</td>
</tr>
</tbody>
</table>
5 Data Management

How can I print the data in the page I am on?  33
Tables  33
Desktop Integration for Excel  37
Attachments  39
Audit  40

6 Social Network

Why should I care about social networking in my application?  43
What does social networking have to do with my job?  43
Social Networking: Highlights  43

7 Scheduled Processes

Scheduled Processes: Explained  47
Process Sets: Explained  47
Submission  48
Management and Output  51
FAQs for Scheduled Processes  54

8 Business Intelligence

Analytics and Reports: Overview  55
Viewing Analytics and Reports  56
Using and Creating Analytics and Reports: Highlights  58

9 Personalization

Page Personalization  61
Springboard Personalization  61
Personalizing Infolets: Procedure  62

10 Preferences

How can I set general preferences for myself?  63
What’s the display name language preference?  63
Uploading My Photo: Procedure  63
Setting Up the Accessibility Modes: Procedure  63
How can I change or reset my password?  64
Proxies  64
Watchlist  65
# Help

- Using Applications Help 67
- Help Types: Explained 68
- Using the Oracle Help Center 69
- FAQs for Help 70

# Troubleshooting

- Troubleshooting Issues: Procedure 71
- Diagnostic Tests 71
- Recording Issues to Troubleshoot: Procedure 73
- FAQs for Troubleshooting 74

# Accessibility

- Accessibility in the Application: Overview 77
- Accessibility Features: Explained 77
- Setting Up the Accessibility Modes: Procedure 78
- Keyboard Shortcuts 79
Preface

This preface introduces information sources that can help you use the application.

Oracle Applications Help

Use help icons to access help in the application. If you don’t see any help icons on your page, click the Show Help icon in the global header. Not all pages have help icons. You can also access Oracle Applications Help at https://fusionhelp.oracle.com.

Using Applications Help

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community**: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.
- **Guides and Videos**: Go to the Oracle Help Center to find guides and videos.
- **Training**: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at Oracle Accessibility Program.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Getting Started

System Requirements

Oracle cloud applications have specific system requirements, including supported resolutions when using internet web browsers. In addition, access to the applications using mobile devices requires additional considerations. You can find the latest system requirements and supported browser resolution settings on the system requirements page at http://www.oracle.com/us/products/system-requirements/overview/index.html. For previous releases, scroll to the end of the page and find the system requirements link for the applicable previous release.

Related Topics

• System Requirements for Oracle Applications Cloud

Signing In and Getting Started

Video

Watch: This video tutorial shows you how to proceed after you sign in to the application. The content of this video is also covered in text topics.

Overview

Use the application link that your company gave you to open the sign-in page, and enter the user ID and password that were also provided. After signing in, you land on the home page, and you have many options to get where you must go to do your tasks. Your home page likely contains multiple views, one of which has a springboard of icons to open work areas. You can also use the global header at the top of the UI, which contains the Navigator, Settings and Actions menu, and other features.
Home Page

The home page has a view that contains a springboard and a panel that, based on setup, shows either company announcements or social networking conversations. The springboard provides icons that you can use to open work areas.

You may also get a page control on the home page that opens other views, such as infolet pages or other configurable pages.

- The first icon in the page control is called Welcome Springboard and it takes you to the springboard.
- Each of the other icons in the page control usually opens up a page with infolets. An infolet is a small, interactive widget, as shown in the following figure, which gives you key information and actions for a specific subject. Infolets have a front view, and may have a back and expanded view. Use the Back View, Front View, and Expanded
View arrows at the bottom corners of an infolet to open these views for more information. Some infolets may also contain links to detailed reports. You can click anywhere in the infolet area to drill down to the detailed report.

The default view that you see after signing in is the view with the springboard, unless your administrator has set up a different default view, for example, the Quick Actions page, as shown in the following figure. Aside from using the page control to navigate between views, you can also use the Next and Previous icons, if available, on the sides of the home page.
Tip: To return to the springboard from another view, click the Welcome Springboard icon in the page control. From any page in the application, click Home or the logo in the global header to return to the home page.

Springboard

The grid of icons on the home page is the springboard. Use the icons to open the work areas and dashboards, where you can do your tasks. The springboard contains page entry icons and group icons. Use page entry icons to open pages and work areas, where you can perform related tasks. For example, you can click the Getting Started icon to open the Getting Started page. On this page, you can see videos and other materials that help you get going in the application as a new user.
Some page entry icons are organized within group icons, such as **Tools**. All group icons in the springboard have three dots as shown in the following figure. When you click a group icon, all page entry icons within the group appear.

![Group Icons](image)

After you open a page from a group, you might see a filmstrip of icons above the page. Use the filmstrip to open other pages from the same group.

**Navigator**

The Navigator is the main menu, found in the global header, which you open using the following icon.

![Navigator Icon](image)

Use this menu to open the work areas and dashboards that you have access to. The content in the Navigator is generally the same as the springboard. But, depending on setup and other factors:

- The Navigator might have more page entries than the springboard.
- A given page entry might appear at the top level in the springboard, but in a group in the Navigator.

**Settings and Actions Menu**

Click your user image or name in the global header to open this menu.

![Settings and Actions Menu](image)

Open this menu to use tools for working with or setting up the application. For example, you can:

- Switch to use the application as someone else, if you’re authorized to do so.
- Set your preferences, including changing your password.
• Personalize or modify the page you’re on (where available).
• Sign out.

If you have access to the My Photo page in general preferences, you can upload your own photo, if your administrator has enabled it. You can find the My Photo page by clicking your user image or name in the global header and selecting **Personalization > Set Preferences > My Photo.**

**Other Global Header Features**

You can use other features in the global header to navigate to your tasks.

For Example:

• **Global Search (if available):** Find what you want to work on and open the corresponding page from the search results.
• **Favorites and Recent Items:** Open pages that you regularly use.
  - **Favorites:** Bookmark application pages, and use these bookmarks to open pages.
  - **Recent Items:** Go to pages that you have opened recently.
• **Watchlist:** Open pages for key items that you’re tracking.
• **Notifications:** View messages that you must attend to, and address tasks that require your action.

You can also use the following icons in the global header:

• **Accessibility:** Set your accessibility preferences, for example, the accessibility modes for the application.
• **Show Help:** Display all help icons on all pages, where available.

**Related Topics**

• Uploading My Photo: Procedure
• Personalizing Infolets: Procedure
• Configuring Home Page Navigation: Procedure

**Exploring Work Areas**

**Video**

Watch: This tutorial shows you examples of work areas and explains how to get started using them. The content of this video is also covered in text topics.
Overview

A work area is a set of pages with everything you need to accomplish a business goal. Each work area has a landing page that you open when you navigate to the work area, for example from the Navigator, springboard, or filmstrip. There are different types of landing pages, and they usually provide ways for you to open other pages within the work area.

General Page Features

Many landing pages and other pages in work areas have one or more of the following:

- Search features that you can use to find records, with results displayed on the page
- Tabs that take you to another page in the work area, or to another part of the page you’re on
- Panel tabs that provide additional tools, for example links to tasks related to the work area

Grid and List Views

Some landing pages have a Grid icon and a List icon. Click these icons to determine how to view the records on the page.

- **Grid**: Display each record as a card, laid out in a grid. A card is similar in appearance to a business card, with a default front side and possibly also a back side. Each side displays a summary view of a single object and may include text, links, and graphics, such as icons, photos, and analytics.
- **List**: Display the same records in a table, with data comparable to what you see on the cards.

In either view, you can usually select actions to take on specific records, or open up the record to see or edit details on another page.

Infotiles

Some landing pages have a row or column of multiple infotiles. An infotile is a container that displays key information about a topic or object. When you select a specific infotile, related information appears on the rest of the page, usually a list of records in a table.

- Many infotiles have links or other elements that you can click to filter the table. For example, a tile displays information about the number of transactions in a certain status:
  - 5 Open
  - 7 Pending Approval
  - 10 Approved

  Each status is also a link, so you can click 10 Approved to see just the ten approved transactions in the table.
- From the table, you can usually perform actions on selected records, or open them up to see or edit details on another page.

Infolets

Some landing pages consist of only infolets. Each infolet is a small, interactive widget that gives you key information and actions for a specific subject related to the work area. Infolets have a front view and possibly also a back and expanded view. From an infolet, you can usually open other pages in the same work area or another work area. You can also personalize the infolet page by moving or hiding infolets.
Performing General Tasks in Your Application: Overview

Perform general tasks as part of using the application to achieve your business goals. Some general tasks are relevant no matter what you’re working on, while others are available only on certain pages.

Search

Use searches to find the business objects that you want to view or manage. While most searches are specific to one object, use the search in the global header for a wider scope.

Watchlist

Use your Watchlist in the global header to track key items and open pages where you work on those items. You can control what’s in your Watchlist.

Notifications and Approvals

You get notifications when something requires your attention or action, for example an expense report pending your approval.

Data Management

Aside from creating, editing, and managing business objects, other tasks for managing data include (where available):

- **Working in a spreadsheet.** Create or edit records in a Microsoft Excel file and upload the records back to the application.
- **Using attachments.** Provide supplementary information for business objects, for example receipts attached to expense reports.
- **Viewing audit history.** See when business objects were created, updated, and deleted, who performed the actions, which attributes were affected, and more.

Social Network

Use conversations and other social networking features to collaborate with others about specific business objects.
Scheduled Processes

Use scheduled processes to manipulate batches of data, and in some cases generate output as reports.

Business Intelligence

Access information that helps you make decisions or meet other business requirements. You can use analyses, dashboards, or reports, and even create or edit them if you have an appropriate role.

Personalization and Preferences

Make changes that apply only to you, for example hide table columns or add regions to a page. You can also use preferences, for example to set your language or change your password.

Help and Troubleshooting

Aside from hints that you might see on the page, you can also use Applications Help to find information about what you’re working on. When you run into an issue you can’t fix, you or your help desk can use troubleshooting tools such as diagnostic tests.

Accessibility

The application provides comparable access to persons with disabilities. For example, you can:

- Use only the keyboard to perform your tasks
- Alter font sizes and screen color
- Use assistive technology such as screen readers

Set accessibility preferences to enable some of these features.

FAQs for Getting Started

How can I change or reset my password?

Use the Preferences page to change your password.

In the global header, click your user image or name and select Set Preferences in the Settings and Actions menu. In the General Preferences section, click Password.
Why are some springboard icons and Navigator menu items not displayed on the springboard or Navigator?

A springboard icon or a Navigator menu may be hidden due to any of the following reasons:

- The administrator hasn’t enabled the offering associated with the group or page entry.
- You may not have security privileges to access or view the group or page entry. If the group or page entry isn’t available on both, the Navigator menu and springboard, then that means you don’t have the appropriate privileges.
- The administrator has hidden the group or page entry from the springboard or the Navigator menu using the Structure page. To review the visibility settings, from the Navigator menu, select Tools > Structure.

**Related Topics**
- Creating Groups and Page Entries for Navigation: Procedure
- Enabling Offerings: Explained
- Configuring Offerings: Procedure

Why are springboard icons appearing at the top level instead of appearing within a folder?

Some page entry icons in the Welcome Springboard are under a group icon by default. But, depending on what you have access to, these page entry icons can actually appear at the top level (not in a group), as described in this table.

<table>
<thead>
<tr>
<th>What You Have Access To</th>
<th>How Icons Are Displayed on the Springboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only one page entry within a specific group</td>
<td>That one icon is displayed at the top level</td>
</tr>
<tr>
<td>Less than 16 page entries total, with duplicate page entries, that is, multiple page</td>
<td>These page entry icons appear in their respective groups</td>
</tr>
<tr>
<td>entries with the same name</td>
<td></td>
</tr>
<tr>
<td>16 or fewer page entries total, which are all unique</td>
<td>All page entry icons are at the top level</td>
</tr>
<tr>
<td>15 or fewer page entries total outside the Tools group</td>
<td>These icons appear at the top level, and only the icons under Tools remain in a group</td>
</tr>
</tbody>
</table>

What determines the icons that appear on the filmstrip?

In the Navigator or springboard, when you use a page entry that’s under a group, you usually get a filmstrip above the page that you open.
Following are some scenarios:

- The filmstrip includes icons for all the simplified pages within the group, even any icons that are currently hidden in the springboard.
- The strip doesn’t appear at all if the page entry you use has no peers within the group.
- If all page entry icons appear at the top level on the springboard, then those icons will appear in the filmstrip for all the simplified pages.

How can I perform tasks on behalf of another user?

To work in the application as another user:

- Click your user name or image in the global header.
- Click the **Switch To** button and select the user.
- Enter your password.

After you’re done working as that user, switch to another assigned account, or sign out and sign in again to your own account.

As a proxy for the selected user, you can access all the data and tasks that the actual user is entitled to. But, you can’t change the user’s preferences.

- **Note:** All tasks that you perform are logged as though the actual user performed them.

**Related Topics**

- Proxies: Explained

What happens when the application is in maintenance mode?

When an application is in maintenance mode, you will see a message on the UI displaying either the scheduled start time or the estimated completion time of the planned maintenance activity. During the maintenance period, the background processes and tasks such as scheduled processes or any report generation activity are put on hold.

Also, the Setup and Maintenance work area is available in a read-only mode.

Once the maintenance is completed, all modules return to their usual state.

Why can't I see the map for contextual addresses?

If you have enabled the pop-up blocker for your browser, you might not see the map when you click the contextual address icon. The contextual address is marked with an orange triangle, the **More** icon. When you hover over the triangle, an icon
appears that you can click to display the address on a map. To view the address on the map, you can disable the pop-up blocker in your browser settings and try again.

---

**Work Address**  
Road Number 1  
Sacramento, 95841  
UNITED STATES

---

**Related Topics**

- Setting Up the Mapping Service for Contextual Addresses: Points to Consider
2 Search

What's the difference between the various searches on the page?

Use the search in the global header, the global search, to quickly find something based on keywords. Especially if you want to search across many business objects (or categories), or you don't have more specific criteria. When enabled, the global search is available no matter which page you're on.

To find specific objects or enter multiple, detailed criteria, use the searches on the pages where you do your work. Some pages also have keyword searches that let you quickly search for the same business object.

Global Search

Using Wildcards and Quotation Marks in the Global Search: Examples

The following scenarios provide examples of using wildcards or quotation marks in the global search. Actual search results may vary, depending on factors such as how the search is set up or what data is available. For example, if you enter account ID as the search term, you should get all records with both words. But if there are no results with both words, then you get records with only one of the words.

Note: The global search:
- Is not case sensitive
- Ignores characters that are not in the indexed language

Using Quotation Marks

Enter multiple words with quotation marks to get records that have the exact phrase. For example, if you search for "currency code", then only records with the exact phrase currency code are included in the search results.

Using Wildcards

Use the asterisk (*) wildcard to get records that replace the wildcard with zero or more characters. Use the question mark (?) to replace the wildcard with exactly one character.

- Enter the wildcard in the middle or at the end of a search term.
- To include * or ? in your search results, precede the symbol with a backslash (\) when you enter the search term. The symbol would not act as a wildcard, but as any other character in your search term.
This table shows some wildcard examples.

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Matches</th>
</tr>
</thead>
</table>
| add*        | • The word add  
|            | • Words beginning with add, such as address |
| country c*  | Phrases such as country code or country club |
| exp?nse     | Words such as expense or expanse |
| exception \*| The phrase exception * |

**FAQs for Global Search**

**How can I select the categories to search on in the global search?**
If personalization is available for the global search (based on setup):

1. Click in the search field.
2. Click the **Personalize** icon in the autosuggest.
3. In the Search Categories tab, select the categories to search on.
4. Click **OK**.

**How can I select the groups to include in the autosuggest for the global search?**
If personalization is available for the global search (based on setup):

1. Click in the search field.
2. Click the **Personalize** icon in the autosuggest.
3. In the Autosuggest Groups tab, select what you want to see in the autosuggest, and set the order that the groups appear in.
4. Click **OK**.

**Why isn’t the global search providing the results that I expect?**
Results are based on indexes that are refreshed on a regular basis. Until the next refresh, you might not find recently created records, or attribute values might be outdated.

The business object you’re looking might not be included in the search.

- Personalize the global search (if enabled) and make sure the search category is selected.
- If you don’t see a corresponding search category to select, then the business object isn't set up for the global search. Instead, use the search in the work area for that object, especially if you want to see the latest information in the search results.

If you ran a saved search, you’re likely to get results that are different from when you created the saved search. The results themselves aren’t saved, so records could have been added, edited, or deleted in the meantime.

Finally, make sure that you’re correctly using symbols (for example wildcards) in search terms.
How can I create a saved search for the global search?

To save search terms and filters for later use in the global search (if available based on setup):

1. Run the search with the search terms that you want to save.
2. In the search results, click the **Show Filters** button if the filters are hidden.
3. Set any filters you want to save.
4. Click the **Save** button.
5. Name your saved search.
6. Close the Edit Saved Searches dialog box.

How can I change the criteria in saved searches for the global search?

In the global search:

1. Run the existing saved search.
2. In the search results, click the **Show Filters** button if the filters are hidden.
3. Update keywords or filters.
4. Click the **Save** button.
5. Leave the name as is to overwrite the existing saved search.
6. Close the Edit Saved Searches dialog box.

How can I rename or delete saved searches for the global search?

In the search results for global search:

1. Click the **Show Filters** button if the filters are hidden.
2. Click the **Save** button.
3. Select your saved search.
4. Rename the search or click **Delete**.
5. Close the Edit Saved Searches dialog box.

Searches on the Page

Using Wildcards and Quotation Marks for Searches on the Page:

Examples

The following scenarios provide examples of using wildcards and quotation marks in search fields. Actual search results may vary, depending on factors such as how the search is set up or what data is available. These examples apply only to searches on the page, not in the global header.

*Note:* In most cases, the search field is not case sensitive.

Using Quotation Marks

In searches with a single field for search terms, enter multiple words with quotation marks to get records that have the exact phrase. For example, if you search for "currency code", then only records with the exact phrase currency code are included in the search results.
Using Wildcards

Use the percent (%) wildcard to get records that replace the wildcard with zero or more characters. Use the underscore (_) to replace the wildcard with exactly one character.

- Enter % or _ at the beginning (only in search fields that are conditionally required or not required), middle, or end of a word.

⚠️ Caution: Using a wildcard at the beginning of a word can affect performance.

- You can use the wildcard more than once in one word.
- If the search criterion has an operator, you must select Starts with or Contains for the wildcard to work.
- To include % or _ in your search results, precede the symbol with a backslash (\) when you enter the search term. The symbol would not act as a wildcard, but as any other character in your search term.

If you’re using an operator other than Starts with or Contains, then you don’t need to precede % or _ with \, for the same effect.

This table shows some wildcard examples.

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Matches</th>
</tr>
</thead>
</table>
| add%        | • The word add
              | • Words beginning with add, such as address                             |
| exp_nse     | Words such as expense or expanse                                        |
| e_p%        | Words such as especially or experience                                  |
| amount \%   | The phrase amount %                                                    |

In some cases, the _ wildcard might not match spaces or symbols that separate words. For example, currency_code might not match currency code or currency/code.

Searches with Multiple Criteria

Saving Searches for Searches with Multiple Criteria: Procedure

On many pages, you can run a search with multiple search criteria to find specific business objects. Some of these searches have a Saved Search list, as well as a Save button after the search criteria. A saved search captures search criteria and other settings so that you can easily run the same search again later. Aside from using any predefined saved searches, you can create and edit them for your own use. If you have the right roles, you can also create and edit saved searches for other users using Page Composer.
The following figure shows an example of a search with multiple search criteria fields and a Save button. For each field, you can select an operator and enter search terms. You can also select from the Saved Search list to use an existing saved search.

Creating Saved Searches
Follow these steps:
1. Go to a search that has a Save button.
2. Optionally add or reorder fields, if available.
3. Enter your search criteria values, and, click the Save button.
4. Name your saved search and define its settings:
   - Set as Default: The saved search is automatically selected whenever you open this page.
   - Run Automatically (if available): The saved search runs on this page as soon as you select it from the list of saved searches.
   If you select both options, then the saved search automatically runs whenever you open this page.
5. Close the dialog box.
Your saved search can be limited to the current page, or in some cases available in other searches for the same object.

Changing the Search Criteria in Saved Searches
Follow these steps:
1. Select the saved search if it’s not selected already.
2. Set your search criteria, including any additional fields.
3. Click the Save button.
4. If the saved search is one that you created, save without changing the name.
   If it’s predefined, then you can’t overwrite it, so you create a new saved search with a unique name.

Changing Settings or Renaming and Deleting Saved Searches
Follow these steps:
1. Go to a search that has a Save button.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches dialog box, select a saved search.
4. Change any of the settings, where available.
   - Set as Default: The saved search is automatically selected whenever you open this page.
   - Run Automatically: The saved search runs on this page as soon as you select it from the list of saved searches.
Show in Search List: The saved search is available for you to select and run on this page.

- You can still find hidden saved searches in the Personalize Saved Searches dialog box.
- You can’t change this setting if the saved search is currently selected on your page.

Note: Some settings can’t be changed for predefined saved searches. What you do change applies only to you, unless you’re editing the saved search within Page Composer.

5. If you selected a saved search that you created, then you can rename or delete it. You can’t do so for predefined saved searches.
6. Save your changes and close the dialog box.

Related Topics
- Creating Watchlist Items: Procedure

What gets saved when I create a saved search for searches with multiple criteria?
The saved search includes the:

- Visible search fields
- Operator and value for each field
- Search mode, either basic or advanced
- Query By Example filters, in some cases

You don’t save the current set of search results or the search result sort order.

Keyword Searches with Filters

Using Filters with Keyword Searches: Procedure
One type of search you might find on the page is a keyword search with filters. The single search field takes your search terms and matches against one or more attributes of a business object. After you run the search, you can use filters to narrow down results.

The following figure shows an example of a search with a single field for search terms, as well as a link to show or hide filters.

Running Searches and Applying Filters
Follow these steps:

1. In the search field, enter search terms and click Search, or select an item from the autosuggest.
2. Click the Show Filters link if filters are currently hidden.
3. Optionally organize filters as follows, depending on what’s available to you:
   - Use the Add or Reorder buttons.
Avoid adding a filter that’s already displayed, unless you’re sure that your filter values can work together to produce search results.

1. Click the **Personalize** icon to show, hide, or reorder filters, and click **OK**.

4. Apply filters as follows, depending on which type of filters is available:
   - Set filter values, and click the **Search** button.
   - Select a filter or set a filter value to automatically refresh results accordingly, and use additional filters to narrow down results further.

### Saving Searches for Keyword Searches with Filters: Procedure

One type of search you might find on the page is a keyword search with filters. Some of these searches have predefined saved searches, and you can also create and edit saved searches for your own use. A saved search captures entered search terms, filters, and other settings so that you can easily run the same search again later. If you have the right roles, you can also create and edit saved searches for other users using Page Composer.

### Creating and Editing Saved Searches

Follow these steps:

1. Enter search terms in the search field, and click **Search**, or select a saved search in the autosuggest.
2. Click the **Show Filters** link if filters are currently hidden.
3. Optionally organize filters as follows, depending on what’s available to you:
   - Use the **Add** or **Reorder** buttons.
   - Click the **Personalize** icon to show, hide, or reorder filters, and click **OK**.
4. Set filter values or select filters, and click the **Save** button.
5. Name your saved search.
   - To create a saved search, enter a new, unique name.
   - To update an existing saved search that you created, save with the original name.

You can’t overwrite predefined saved searches by using their names, but you can create a copy with a unique name.

6. Click **Set as Default** if you want the saved search to be automatically selected whenever you open this page.
7. Click **OK**.

Your saved search can be limited to the current page, or in some cases available in other searches for the same object.

### Changing Settings or Renaming and Deleting Saved Searches

Follow these steps:

1. Click the **Show Filters** link if filters are currently hidden.
2. Select **Manage** from the **Saved Search** list.
3. Define settings for any saved search, predefined or user-defined, in the Manage Saved Searches dialog box:
   - **Default**: The saved search is automatically selected whenever you open this page.
   - **Show in Saved Search List**: The saved search is available for you to select and run on this page. You can still find hidden saved searches in the Manage Saved Searches dialog box.
Note: Changes you make to predefined saved searches apply only to you, unless you’re editing the saved search within Page Composer.

4. The Active setting identifies the saved search that’s currently selected on the page. You can designate a different active saved search to have that saved search automatically selected as soon as you click OK in this dialog box.

5. For user-defined saved searches only, you can also rename or delete the saved search.

6. Click OK.
3 Watchlist

Watchlist: Overview

Use the Watchlist to track important business objects and open the pages where you work on those items. Items are organized into categories, and the Watchlist tells you how many of each item you have. For example, in the Expenses category, one Watchlist item is the Reports awaiting submission link. You can click the link to open the Expenses work area, and edit and submit those two expense reports. To open your watchlist, click the Watchlist icon in the global header.

Personalization

Aside from using predefined Watchlist items, you can create your own items, based on saved searches. You can also use preferences to determine which categories and items to show or hide in your Watchlist.

Creating Watchlist Items: Procedure

Some saved searches are available for you to use as Watchlist items. Open a page that has saved searches and the Manage Watchlist button enabled. All saved searches from this page that you designate as Watchlist items would appear within one predefined Watchlist category.

Using Saved Searches as Watchlist Items

Follow these steps:

1. Create a saved search or decide which existing one to use as a Watchlist item.
2. Click Manage Watchlist.
3. Select the saved search you just created or any other that you want to use as a Watchlist item.

Removing Saved Searches from the Watchlist

To remove a Watchlist item based on a saved search, deselect it in the Manage Watchlist dialog box. If you deleted the saved item first, then also deselect it from the Manage Watchlist dialog box. Otherwise, it remains in the Manage Watchlist dialog box and your Watchlist until the next refresh.

Related Topics

- Saving Searches for Searches with Multiple Criteria: Procedure
Displaying and Hiding Watchlist Items: Procedure

Use your Watchlist preferences to show or hide specific items or categories in your Watchlist.

The preferences contain:

- All the predefined Watchlist categories and items available to you
- Any saved searches you’re using as Watchlist items

Setting Watchlist Preferences

Follow these steps:

1. Click your user name or image in the global header, and go to Personalization > Set Preferences > Watchlist.
2. Use the Enabled check box to display or hide any Watchlist item or category.

✏️ Note: Disabling a category automatically hides all of its items.

3. Optionally hide enabled Watchlist items that show no records.

FAQs for Watchlist

Why are some items not displayed in my Watchlist?

Items might be hidden based on your Watchlist preferences. These preferences also apply to saved searches that you’re using as Watchlist items. To review your preferences, select your user name or image in the global header, and go to Personalization > Set Preferences > Watchlist.

Other possibilities could be that:

- You deselected saved searches in the Manage Watchlist dialog box, so they’re no longer used as Watchlist items.
- You deleted saved searches that were used as Watchlist items.
- Your administrator disabled specific predefined Watchlist items or categories for all users.
- Your administrator disabled using saved searches (from specific pages) as Watchlist items.
- Your administrator revoked access to tasks or pages that used to be available to you.

In these cases, you can no longer see the corresponding Watchlist items in your Watchlist and in your Watchlist preferences.

How can I rename Watchlist items?

If the item is your saved search, then rename the saved search itself. The Watchlist item name gets updated the next time that the Watchlist refreshes.
You can’t rename predefined Watchlist items yourself. You can ask your administrator to do so, but the changes apply to all users.

Related Topics

- Saving Searches for Searches with Multiple Criteria: Procedure

Why is the count different between a Watchlist item and the page that the item link takes me to?

Watchlist item counts are refreshed periodically. Relevant records could have been created, edited, or deleted since the last refresh.
4 Notifications and Approvals

Workflow Tasks: Overview

Workflow is an automated process that sequentially passes a task from one user (or group of users) to another. After all assignees address the task, for example by approving it, an end result is achieved. Some tasks are for your information (FYI) only and require no action from any assignee.

Access to Tasks

When a task is assigned to you, you get a notification in the application and in your e-mail. All tasks relevant to you are in your worklist. To access workflow tasks, you can use the:

- E-mail notifications
- Notifications list in the global header
- Worklist: Notifications and Approvals work area (Navigator > Tools > Worklist)
- Worklist: Notifications and Approvals region on My Dashboard

Examples

Examples of interaction with workflow tasks include:

- When you submit a transaction for approval, you automatically create a workflow task that gets routed to your approvers. If an approver sends the task back to you for more information about your transaction, your action is to provide the requested information. When the transaction is ultimately approved or rejected, you simply get a notification that requires no action from you.
- If you’re a manager and your employee submits a transaction that requires approval up the management chain, your action is to approve or reject the transaction. Other options might be available; for example, you can delegate the task so that someone else does the approval for you.

Actions and Statuses for Workflow Tasks: Explained

The status, or state, of a workflow task tells you where it’s at in the approval process. When you’re assigned to a task, what you can do with it depends on many factors, including what the task is and its current state.

Actions

This table describes some possible actions you can take on workflow tasks.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad Hoc Route</td>
<td>Add approvers to the task.</td>
</tr>
</tbody>
</table>
### Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>Approve the task, and the task completes or moves on to the next approver.</td>
</tr>
<tr>
<td>Claim</td>
<td>Assign the task to yourself so that you can act on it, if the task is currently assigned to a group.</td>
</tr>
<tr>
<td>Create Subtask</td>
<td>Create a child task to be completed as part of the original task.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Pass the task to someone else to take action for you, but the task is still assigned to you.</td>
</tr>
<tr>
<td>Dismiss</td>
<td>Close the task and acknowledge that you received it. You don’t need to take action because the notification is only for your information.</td>
</tr>
<tr>
<td>Escalate</td>
<td>Reassign the task to your direct manager.</td>
</tr>
<tr>
<td>Push Back</td>
<td>Reassign the task to the previous approver.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Reassign the task to someone you select.</td>
</tr>
<tr>
<td>Reject</td>
<td>Reject the task and send it back to its creator in a final state.</td>
</tr>
<tr>
<td>Release</td>
<td>Make the task available for other approvers in the group to claim.</td>
</tr>
<tr>
<td>Renew</td>
<td>Give yourself more time (seven days is the default) to act on the task, if the task is about to expire.</td>
</tr>
<tr>
<td>Request Information</td>
<td>Ask the task creator or any of the previous approvers for more information.</td>
</tr>
<tr>
<td>Resume</td>
<td>Revive a suspended task and continue working on it.</td>
</tr>
<tr>
<td>Skip Current Assignment</td>
<td>Reassign the task to the next approver.</td>
</tr>
<tr>
<td>Submit Information</td>
<td>Send the information that was requested of you regarding the task.</td>
</tr>
<tr>
<td>Suspend</td>
<td>Put the task on hold until it’s resumed. In the meantime, no one is assigned to act on it.</td>
</tr>
<tr>
<td>Withdraw</td>
<td>Remove the task from the workflow (available only if you created the task).</td>
</tr>
</tbody>
</table>

### Statuses

This table describes some possible statuses, or states, for workflow tasks.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned</td>
<td>Task is assigned to you and awaiting your action.</td>
</tr>
<tr>
<td>Completed</td>
<td>Final user in the workflow has addressed the task.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Errored</td>
<td>Task is in error and can’t be recovered.</td>
</tr>
<tr>
<td>Expired</td>
<td>Current assignee hasn’t addressed the task within any defined renewal period.</td>
</tr>
<tr>
<td>Information Requested</td>
<td>Assignee requests more information from any user.</td>
</tr>
<tr>
<td>Suspended</td>
<td>Task is put on hold by the task creator and not assigned to anyone to address.</td>
</tr>
<tr>
<td>Withdrawn</td>
<td>Task creator removes task from the workflow.</td>
</tr>
</tbody>
</table>

Viewing and Acting On Notifications: Procedure

Use the **Notifications** icon in the global header to open your notifications list. Notifications alert you that something requires your attention or action. The icon itself displays the number of pending notifications you have, if any. Pending means that you have not yet acted on the notification nor marked it as read. Most notifications are for workflow tasks.

The following figure shows the notifications list in the global header. In this example, the Notifications icon indicates that there are 27 pending notifications, one of which is a new notification and just FYI. The other notification in the figure requires action, and you can approve or reject even without opening the notification.

![Pending Notifications](image)

The language of the notification title might not be the same as the language that you selected when you signed in to the application. The title is always displayed in the language that was used when something generated the notification.
Addressing Notifications

To view and act on notifications:

1. Click the **Notifications** icon in the global header.
   
   The **Unread** icon, a blue dot, identifies any new notifications in your list. Even if you close the list now without doing anything else, the same notifications are no longer new the next time you open the list.

2. Click the drop-down button next to the window title to switch between pending notifications and all notifications. You can also:
   
   - Search the notification titles.
   - Click the More Details button to view and manage workflow tasks in your worklist.

3. For a notification requiring action, you can click the:
   
   - **Approve** or **Reject** link, where available.
   - **Actions** menu and select an action, where available.
   - Notification title to open the details and select from all possible actions you can take. For workflow tasks, you get the same task details that you do from your worklist, using the Worklist: Notifications and Approvals work area or region.

   The notification is considered acted upon and taken off the pending list.

4. For a notification that doesn’t require action, you can:
   
   - Click the **Clear** icon that appears when you hover over the notification, to dismiss the notification.
   - Click the notification title to open the details. It’s possible that nothing appears when you click a notification that doesn’t require action, because there are no details to display.
   - Do nothing except read the notification title, if the title is just text and not a link because there are no details to display.

   In all cases, the notification is considered read and taken off the pending list. To keep a notification as pending, you can click the **Undo** link that temporarily appears next to the notification title after you click the title or Clear icon.

Using Your Worklist for Workflow Tasks: Procedure

While you can use the notifications list in the global header to address recent notifications for workflow tasks, you can also use the Worklist: Notifications and Approvals work area for comprehensive access to all of your workflow tasks. For example, you can keep track of tasks that you created, or browse for tasks by status.

You can also add the Worklist: Notifications and Approvals region to My Dashboard to access your worklist there. You get a quick view of all the tasks that are currently assigned to you.

Using the Worklist: Notifications and Approvals Work Area

Follow these steps:

1. Click **Navigator > Worklist**.
2. Use the **Status** drop-down list to indicate what tasks to see.
3. Click the task title to view the task details.
Tip: To act on a task without viewing the task details, you can select the row and use the Actions menu in the table toolbar.

4. For tasks requiring your action, use the buttons or Actions menu on the task details page. Possible options in the Actions menu include:

   - **Request Information**: Select the person you want information from, and specify what you’re asking for in the Comments field. Indicate if the task should come right back to you or go through the usual workflow process, after the assignee has provided the requested information.
   - **Reassign**: Select whom to pass the task on to. Indicate if you’re reassigning the task or just delegating it for someone to act on your behalf.

5. In the task details, you might also be able to:

   - Click the Create icon in the Comments section to add your own comment about the task.
   - Click the Add icon in the Attachments section to attach a file to the task.
   - View the approval history in the History section. The table and graph present two views of the same history, listing past assignees in sequential order and indicating the status of each assignment. Hover over the boxes in the graph to see more information.

6. For additional things you can do with your worklist, click View from the table toolbar in the Worklist: Notifications and Approvals work area. Select Servers and click the Worklist link.

Adding and Using the Worklist: Notifications and Approvals Region

Follow these steps:

1. Select My Dashboard from the Navigator.
2. Click your user name in the global header, and select Edit Page in the Personalization menu group.
3. Click the Add Content button where you want to place the region.
4. Open the Application Content folder in the Add Content dialog box.
5. Click Add for the Worklist: Notifications and Approvals item.
6. Click Close.
7. Save your work, and then click the Close button.
8. The Worklist: Notifications and Approvals region displays all tasks assigned to you. See steps 4 through 6 for using the Worklist: Notifications and Approvals work area.
Defining a Vacation Rule for Workflow Assignments: Explained

Define a vacation rule to determine what happens to workflow tasks that are assigned to you while you’re out of office. You can reassign your tasks to others, or delegate it to them to act on your behalf.

Enabling and Defining the Rule

Follow these steps:

1. In the global header, click the Notifications icon.
2. Click More Details.
3. In the new browser window, click your user name and select Preferences.
4. In the My Rules tab, select the Vacation Period rule if it isn’t already displayed.
5. On the Vacation Period page, select the Enable vacation period check box, and enter the start and end date for your vacation.
6. Select to reassign or delegate your tasks, and provide an assignee.
7. Save your work.
FAQs for Notifications and Approvals

Why are workflow notifications that I already took action on still pending in the global header?

The notifications in the global header don’t immediately reflect changes to the workflow task status if you took action elsewhere, for example through email or the Worklist: Notifications and Approvals work area. Such notifications will move from the Pending Notifications list to the All Notifications list after the next scheduled run of the Synchronize Notifications in Global Header process.

Related Topics

- Synchronizing Notifications in the Global Header with Workflow Tasks: Points to Consider

How are notifications removed from the list in the global header?

Old notifications aren’t automatically removed. You must click Notifications in the global header and run a search. Notifications older than 30 days are then removed from the list of all notifications. If a removed notification is for a workflow task, then you can still find the task in the Worklist: Approvals and Notifications work area (click Navigator > Worklist).
5 Data Management

How can I print the data in the page I am on?

Click your user name or image in the global header and select Print Me, if available, from the Settings and Actions menu. You get a view of the page, which you can then print using your browser’s standard print feature. This view includes any field, table, or other UI element on the page that has data. If the page has tabs, then only the currently open tab is included.

If you want just the data in specific tables, you can also use the Export to Excel button or menu option on the table, if available. You get a Microsoft Excel file containing data from the table, which you can then print.

Tables

Using Tables: Explained

You can find tables on many pages. Some tables are simple, while others give you several options to view and manage the data. Many of these options are described here, and they may or may not be available on the particular table you’re using. You can find most of the options in the table toolbar, which usually has menus such as Actions, View, or Format.

Selecting Data

To select a row or column:

- **Row:** Click anywhere within the row. Or, hover over the small cell beside first column, and click when your cursor becomes an arrow.
- **Column:** Hover over the column heading and click when your cursor becomes an arrow. In tables that allow multiselect, you can use the Shift or Control key to select multiple rows at once.

> **Note:** Some items in the table menus or toolbar are disabled until you select a row or column. For example, only after selecting a row can you then select About This Record from the View menu, to see who created and last updated the record, and when.

Viewing Data

To help you view the data in the table, you can:

- Use filters in the toolbar or Query By Example to narrow down the data. Query By Example is the row of fields that precedes the column headings.
- Click Refresh in the toolbar, or select Refresh from the Actions menu. You reload the table with the latest available data.
- Click Detach in the toolbar, or select Detach from the View menu. You can see more of the table in the detached view.
- Select a column and click Wrap in the toolbar, or select Wrap from the View menu. You can see all the text in each cell within the column.
• Click Export to Excel in the toolbar, or select Export to Excel from the Actions menu. You get a Microsoft Excel file with the data in the table.

**Sorting Data**
To sort the data in the table:

• Hover over the column heading of the column you want to sort by, and click the Sort Ascending or Sort Descending icon.
• Select Sort from the View menu.

**Editing Data**
To edit data in a table, you can:

• Select a row and click Edit in the toolbar to open a dialog box or another page.
• Click a link in the row to open a dialog box or another page.
• Click a row to make that row editable within the table.

**Managing Columns**
To determine which columns to see and how they appear, you can:

• **Hide or show**: Select Columns from the View menu.
• **Resize**: Hover between column headings and drag the divider. Or, select the column, and then select Resize Columns from the Format menu.
• **Reorder**:
  ○ To move a column, click the column heading and, when your cursor becomes two double-pointed arrows, drag the column to a new position.
  ○ To reorder multiple columns, select Reorder Columns from the View menu.
• **Freeze**: Select the column that you want to freeze, and then either click Freeze in the toolbar or select Freeze from the View menu.

**Query By Example**

**Using Query By Example: Procedure**
Query By Example is the row of fields that precedes the table column headers, used for filtering the data in the table.

Applying the Query By Example Filter
Follow these steps:

1. Click Query By Example on the table toolbar if the row of fields isn’t displayed.
2. Enter filter values in any or all of the Query By Example fields.
3. Press Enter.

The table now shows only the records that meet the criteria you entered in all Query By Example fields.
Refreshing the Filtered Results
Do any of the following:

- Press Enter again with your cursor in any of the Query By Example fields.
- Click Search or Refresh on the toolbar, if available.
- Select Refresh from the View menu, if available.

⚠️ **Note:** The filter applies even if the Query By Example fields are hidden.

Removing the Query By Example Filter
Click the Clear All icon at the beginning of the Query By Example row, if available.

If not, then:

1. Delete what you entered in each Query By Example field.
2. Refresh the table.

To clear not just Query By Example but any other table filters:

1. Select Clear from the View menu or click Clear on the table toolbar, if available.
2. Refresh the table.

Operators and Wildcards for Query By Example: Explained
You can use operators and wildcards in Query By Example fields. Operators and wildcards work in alphanumeric fields only, not date fields.

Operators
This table describes the operators that you can enter in Query By Example fields.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
</table>
| None (you enter only a value) | - **Character field:** Starts with  
- **Number or date field:** Equals |
| > | Greater than |
| < | Less than |
| >= | Great than or equal to |
| <= | Less than or equal to |
| and | And |

⚠️ **Note:** You can use this operator only in conjunction with other operators, for example: >0 and <=1000.

| or | Or |
For the >, <, >=, and <= operators:

- Results are based on alphanumeric sort, in alphanumeric fields. For example, if you enter >=ABC, then ABC, ABD, ABCA, ACB, and BAC are matches, but not AB5 or AB.
- A space is considered part of the filter value. For example, if you enter >= ABC, then ABC and ABD are matches only if they’re preceded with a space.

Wildcards

This table describes the Query By Example wildcards that you can use at the beginning, middle, or end of your entered value. All other symbols are ignored.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| *        | Multiple characters | Entered Value: add*  
|          |             | Matches: The word add and words beginning with add, such as address |
| ?        | Single character | Entered Value: exp?nse  
|          |             | Matches: Words such as expense or expanse |

Export to Excel

What’s the difference between export to Excel and desktop integration for Excel?

Use the Export to Excel button or menu option to download data from a table to view or analyze. You get a Microsoft Excel file, of any type that Excel supports, with records from the table.

Use the desktop integration for Excel to create or edit records in an Excel workbook and upload the records back into the application. It’s helpful for mass updates or working offline. In most cases, you download the desktop integrated workbook from a link in a panel tab, the regional area, or a table.

What’s included in the file I get when I export a table?

You get the rows you select in the table. If row selection is disabled or you don’t select anything, then you get all rows, including any that are not visible on the page.

In any case, some data might not be included if:

- Any search criteria, filters, and Query By Example values apply to the table.
- The table has any hidden columns.
- You’re working with a table that shows a certain number of rows per page or view. Try going to subsequent pages or views to export.
Translation Editor

Using the Translation Editor: Procedure

For a particular row in the table or for a field in a form, you can use the translation editor (when available) to view or enter the translated text for the supported languages. You can perform this action without signing out of your current session. If the translated text is in a language that’s same as the language of your current session, you can see the translation apply to the UI immediately.

Follow these steps:

1. Click Translation Editor on the table toolbar or in the form.
2. On the Edit Translations dialog box, select the row of your preferred language and enter the translated text in the editable fields. You can enter translation text for multiple languages.
3. Click OK to save your updates.

What’s the difference between Language and Source Language?

Language refers to the language setting that is active for the application when the user signs in.

Source language refers to the language in which the text value is created. If multiple languages are active, the same text value, in whichever language is it created, is the default text in all translations because the actual translation isn’t yet available.

When other values are entered for the translated values in different languages, the source language for each row is overridden with the language of translation.

Desktop Integration for Excel

Setting Up the Integration: Points to Consider

You can create or edit records that you can upload to the application using Desktop integrated Excel workbooks. To use these workbooks, you must install an Excel add-in.

Prerequisites

Perform these prerequisite tasks before you install the Excel add-in.

- Make sure you have an Excel and Windows version that’s listed in Supported Platforms for ADF Desktop Integration (2242428.1) on My Oracle Support at https://support.oracle.com.
- If you’re reinstalling the Excel add-in and currently have a version older than 11.1.1.7.3 (4.0.0), then uninstall the existing Oracle ADF Desktop Integration Add-In for Excel the same way you uninstall any program on your computer.

💡 Tip: You can find the version in the control panel where you uninstall programs.

- Optionally install the following from the Microsoft website.
  - Microsoft .NET Framework 4.5.2
  - Microsoft Visual Studio 2010 Tools for Office Runtime (VSTO Runtime)
The add-in installer does check if you have these already, and would download and install them if needed. But, you can manually install them first, especially if you run into issues installing them as part of installing the Excel add-in.

Installing the Desktop Client

To install the Oracle ADF 11g Desktop Integration Add-In for Excel:

1. Make sure you are signed in to your computer with your account. For example, you can't have someone else sign in as an administrator and make the installation available for everyone using your computer.
2. In the application, look for the client installer in Navigator > Tools.
3. Run the installer (adfdi-excel-addin-installer.exe) as you would any program that you install on your computer.

Using Desktop Integrated Excel Workbooks: Points to Consider

Where available, you can download a desktop-integrated Microsoft Excel workbook and use it to create or edit records. Your edits in the workbook don’t affect the application until you upload the records back into the application.

What You Must Not Do

To ensure that you successfully upload to the application, don’t:

- Rename text from the integrated workbook, for example the worksheet or tab names.
- Add columns.
- Delete any part of the template, for example columns.
- Hide required columns and status columns or headers.

⚠️ Caution: Avoid using the Windows Task Manager and clicking End Task to close Excel. Doing so might disable the add-in.

Conventions

Some column headers in the integrated workbook might include [..]. This means that you can double-click or right-click within any cell in the column to open a dialog box, which lets you select a value to insert into that cell.

Statuses

To use the Status Viewer:

1. Open the tab for your task in the Ribbon, if available. For example, if you downloaded a workbook to create expense items, the tab is called Create Expense Items.
2. Click Status Viewer.
3. In the worksheet, click any table row to see the status of the row, including messages for any errors. The Status Viewer always shows the status of the entire worksheet.

Searches

Some integrated workbooks have searches. To search within the workbook, you must be signed in to the application. When you click the search button, the application prompts you to login if you haven’t already logged in.

Refreshes After Upload

If your changes aren’t reflected after an upload, try the following to refresh the table in the application:

- Use the refresh option for the table
Troubleshooting the Integration: Procedure

The application is integrated with Microsoft Excel so that, where available, you can work with records in a desktop integrated workbook. You might run into issues with the integration, for example, if you can’t open the workbook that you downloaded or the workbook doesn’t look right. You can use the Client Health Check Tool. For more information see Information Center: Troubleshooting Oracle ADF Desktop Integration (2012600.2) on My Oracle Support at https://support.oracle.com.

Using the Client Health Check Tool

Use the health check tool to find out what integration issues you might have and how to resolve them. Ask your help desk if you are unable to find or use the tool.

1. Download the latest version of the health check tool from How to use ADF Desktop Integration Client Health Check Tool (2010222.1) on My Oracle Support at https://support.oracle.com.
2. Run ClientHealthCheck.exe as you would other programs on your computer, and review the result for each checked item.
3. Select any item that has a problem, and read the help text.
4. Fix some of the problems by clicking the Fix Problems button. Otherwise, follow the instructions in the help text.
5. If you need more assistance, click the Save Report As button to prepare information for your help desk.
6. Review the report and remove any sensitive information.
7. Contact your help desk and provide your report.

Attachments

How can I delete attachments?

Use the Delete icon button. Alternatively, you can use the Manage Attachments icon button to open the Attachments dialog box and delete specific attachments.

Can I view attachments in a different format?

Attachments, by default, appear in the table view. You can also view them in two other ways, list view and cards view, if the options are enabled.

To switch between the different views, click the toggle buttons on the toolbar.

How can I filter attachments?

Use the filtering options, if enabled, on the toolbar of the attachments window to display only those attachments that are specific to your search. You can filter attachments by Type, Title, Description, Category, and so on.

If you filter the attachments by Type, you get additional options to search for a specific file, folder, text, or a URL.
What happens if I update an existing attachment?

If an attachment of the same type and name is uploaded again for the record, the attachment gets stored as a new version. The previous attachment remains available, displaying the time stamp to indicate how old that version is. To view the version of an attachment for a record, click **File Revision History** under Actions.

By default, always the latest attachment appears for a particular record. However, if the option is enabled, you can pick any other version of that attachment and set it to default. Anyone viewing the attachment for that record will see the default version that you set, even if that’s not the latest one.

Audit

Audit History: Explained

Using audit history you can view changes to the application data such as the business objects that were created, updated, and deleted. To view the history or to create a report, you must have a role with the assigned privilege View Audit History (FND_VIEW_AUDIT_HISTORY_PRIV). For appropriate assignment of roles and privileges, check with your security administrator.

To open the Audit History work area, from the Navigator menu, select **Audit Reports** under **Tools**.

The default search displays a summary of the audit history in the search results table. It includes key data such as date, user, product, event type, business object type, and description. For a detailed report, search again with modified search criteria. You can export the report summary to Microsoft Excel.

The following table lists the search parameters used and the outcome of their selection in the detailed report.

<table>
<thead>
<tr>
<th>Search Parameter</th>
<th>Result of Selection</th>
</tr>
</thead>
</table>
| Business Object Type      | • Narrows the search results to that specific business object within the selected product.  
                            | • Enables the Show Attribute Details check box.                                      |
|                           | **Note:** This parameter is applicable only for the business objects that belong to Oracle Applications Cloud. |
| Include Child Objects     | Displays all the child objects that were listed under the business object when audit was set up. For example, a sales order object that contains several items as child objects. |
|                           | **Note:** Displays the objects at the immediate parent-child level only. To view the children at subsequent levels, select the child object as the business object type and search again. |
| Show Attribute Details    | Enables the attribute list so that users can select either all attributes or a specific attribute to view the changes. Based on the selection, the search results indicate whether the attribute is created, updated or deleted, and the corresponding old and replaced values. |
Note: The default report displays a standard set of columns that contain prominent details of the audit history. To view additional details, you can change the display of columns.

Audit Event Types: Explained

Events trigger the audit process and the event details are stored in the audit table. Along with audit history, you can view which events triggered the changes to the object data within a given period of time. However, for events to trigger the audit process for the business objects, the objects must be enabled for auditing.

For Oracle Applications Cloud, transactional events trigger the audit process based on the create, update, and delete operations. The attributes of the audited object data can be used in lookups and foreign keys to display values in the audit history. Oracle Applications Cloud supports displaying the audited information as per the application’s language settings.

For Oracle Fusion Middleware products, events such as failed sign in attempts are used as triggers. In absence of an audit table, the information is stored in the sandbox and presented only in English.

Note: This topic focuses on the create, update, and delete event types available in Oracle Applications Cloud. For details on events used in the Oracle Fusion Middleware products, refer to the Oracle Fusion Middleware documentation.

- Create Operation - This event triggers audit activity whenever business object data is created and stored in the database. The audit report displays the name of the created object, the name of the user who created the object, and the time stamp.

- Update Operation - This event triggers audit activity whenever the existing business object data is updated. The audit report displays both the old and updated values of the object, the name of the user who updated it, and the time stamp.

- Delete Operation - This event triggers audit activity whenever the existing business object data is removed from the database. The audit report displays the last value that the object attributes contained and the name of the user who deleted the object.
Why should I care about social networking in my application?

Wouldn’t it be great if you could instantly share an aspect of your application with everyone who plays a part in getting the job done? Without having to start an untold number of e-mail threads that then get forwarded to other people, until it’s impossible to know who’s in charge of what?

When you share a business object with the social network - like a Sales Opportunity or a Purchase Order - you create a Social Object. With the Social Object, you can bring all your stakeholders together in a single place to get the collaborative ball rolling and keep a record of everything that has transpired. So, new folks can easily jump in and come up to speed.

What does social networking have to do with my job?

Social networking isn’t just for social situations anymore.

Here are some key reasons for using social networking in your business applications:

- In a business object, open Conversations on the spot and discuss details while looking at them. No worries about keeping two sets of data synchronized. The details you see in your social network are the same you see in your business application.
- All communications are organized automatically by business object, so no wasted time with filing and searching through e-mails.
- Quickly engage resources as needed to address issues or solve problems. Invite new members to the Conversation so that they can easily see the complete history.
- Share presentations and other documents, and get inputs from other team members. Web conference not required. Juggling e-mail responses not required.
- Get real-time notifications about updates to key Conversations.
- Develop and expand your professional network.
- Connect and engage with others covering the same industry, product specialization, or geography.

Social Networking: Highlights

Social networking includes many features to make collaborating on projects easier.

You can use Oracle Social Network features in:

- Oracle Sales Cloud
- Oracle Global Human Resources Cloud
- Oracle Financials Cloud
• Oracle Procurement Cloud
• Oracle Project Portfolio Management Cloud
• Oracle Risk Management Cloud
• Oracle Service Cloud
• Oracle Supply Chain Management Cloud
• Oracle Talent Management Cloud

Get Started

• View social activity surrounding business objects.
  See: How do I get to Oracle Social Network?
• Get an overview of recent social activity, keeping you up to date on the business objects you’re interested in.
  See: How do I use the Oracle Social Network user interface?
• Share a business object in the social network to enable easy collaboration with the right people.
  See: How do I share or join a Social Object in the social network?

Post and Upload Content

• Start a Conversation about a business object, posting messages and sharing documents with everyone involved.
  See: How do I start a Conversation?
• Post, reply to, and like messages to participate in Conversations.
  See: How do I post a message?
• Upload documents to get comments and annotations from others.
  See: How do I upload a document?

Interact With Others

• Connect with others in the social network to follow their activity and communicate with them directly through one-on-one Conversations.
  See: How do I view a person’s profile or interact with someone in Oracle Social Network?
• Create groups to make sure you include all the right people in your Conversations.
  See: How do I create a group?
• Flag people to bring their attention to important messages.
  See: How do I assign flags to others?
• Start web conferences directly from a Conversation to have live discussions with all interested parties.
  See: How do I start or end a conference?
Organize and Find Content

- Create collections to group associated business objects, Conversations, people, and groups.
  See: How do I create a collection?
- Use search, hashtags, and favorites to easily find content.
  See: Finding Content

Access Your Social Activity

- Download other clients to access your social activity from Microsoft Outlook, your desktop, or your mobile device.
  See: How do I get to Oracle Social Network?
Scheduled Processes

Scheduled Processes: Explained

Run scheduled processes to manipulate a set of records for a specific business need, or to get printable output with information about certain records. Some processes do both, for example, to import records and provide a report about them.

Report Output

A scheduled process that provides output, or the output itself, is also referred to as a report.

- Many types of reports are available, for example regulatory statements or listings of records that meet specified parameters.
- Predefined templates determine the report layout.

Parameters

A scheduled process might have parameters that you can set to control which records are included or how they are affected. For example, a process updates only the records that are effective within the date range that you define.

Submission

Each scheduled process that you run is based on a job. The job is the executable that determines what the process can do and what options you can set for the process.

You can submit the same process using different parameters and other settings. Each process submission has a unique process ID.

Process Sets

A process set is a scheduled process that's based on a job set, which contains multiple jobs for one process submission.

Note: In some cases, when you submit a scheduled process, the job logic causes other processes to automatically run. This isn't the same as a process set.

Related Topics

- Creating Job Sets: Procedure

Process Sets: Explained

A process set is a type of scheduled process that contains at least two processes to run as part of one submission. These processes run in a specific order, in serial or parallel, or based on other predetermined logic.
Process Set Content

Process sets can contain any number of individual scheduled processes as well as other process sets. There can also be multiple levels of nested process sets within a single process set. For example, a process set can include three processes and two process sets, one of which contains another process set.

Job Sets

Just as individual processes are based on jobs, process sets are based on job sets. A job set:

- Is a predefined set of jobs to be included in one process submission
- Can contain nested job sets

Submission

Submitting Scheduled Processes and Process Sets

Video

Watch: This tutorial shows you how to submit a scheduled process, monitor its status, and view the output the process generates. The content of this video is also covered in text topics.

Procedure

Use the Scheduled Processes Overview page to run all the scheduled processes, including process sets, that you have access to. You can also submit many predefined scheduled processes from some of the other work areas.

Using the Reports and Analytics pane, you can also submit reports that are registered as scheduled processes. You can find this pane in many work areas, including the Reports and Analytics work area (Navigator > Tools > Reports and Analytics).

Selecting the Scheduled Process and Defining Parameters

To submit from the Scheduled Processes Overview page:

1. In the Scheduled Processes work area, click Schedule New Process.
2. Leaving the type as Job, schedule the process that you want to submit, and click OK.
3. In the Process Details dialog box, enter the required parameters.

Note: Some parameters are dependent on other parameters and may appear based on what you specify.

4. You can perform one of the following actions:
   - Click the Advanced button to:
     - Define schedule
     - Define document output
- Define notifications
  - Skip to the steps for finishing the submission, and submit with the default schedule to run the process once as soon as possible with output, if any.

**Defining the Schedule**

You can define the schedule so that the job runs on specified recurrence. In the **Process Details** dialog box (Advanced mode):

1. Open the Schedule tab and select **Using a schedule**.
2. Select a frequency.

   For frequencies other than **Once**, the **Auto Increment** check box is enabled by default. Keep the check box enabled to run the recurring jobs with the same schedule specifications. To specify a different schedule for the recurring jobs, deselect the check box.

3. Set the process to run at a specified interval within a date range.

   Or, if you selected **Custom** for frequency, enter the exact dates and times to run the process.

**Defining the Output**

You can specify the layout, format and destination for your output. In the **Process Details** dialog box (Advanced mode):

1. Open the Output tab, if available.
2. Click **Add Output Document**.
3. Select a layout if you have more than one to choose from.
4. Select one of the available formats, which can include:
   - **PDF**: Is the best option if you want to print the output.
   - **Excel**: Supports embedded images, such as charts and logos, but can be opened only in Excel 2003 or higher.
   - **Data**: Gives you report data in XML, used mainly for editing the report layout.
5. Click **Add Destination** to send the output to a printer, email address, fax or content server. You can add multiple destinations and send the output to all at the same time.
6. To add more output documents, repeat steps 2 to 5.

**Setting Up Notifications**

You can set up notifications for different stages of the process. In the **Process Details** dialog box (Advanced mode):

1. Open the Notification tab.
2. Click **Create Notification**.
3. Enter the user ID that the recipient uses to sign in to the application.
4. Define when to send the notification, for example when the process ends in error.
5. Click **OK**.
6. To add more users, repeat steps 2 to 5.

**Finishing the Submission**

In the Process Details dialog box:

1. Click the **Process Options** button if you want to define settings that affect the data to be processed.
2. Select the **Notify me when this process ends** check box if you want to get an email notification.
3. Enter submission notes to capture any information you want to associate with this submission.
4. Click **Submit**.
5. Click **OK** for the confirmation.
6. Close the Process Details dialog box.

### Submitting Process Sets

To submit a process set from the Scheduled Processes Overview page:

1. Proceed as you would to submit any scheduled process, but select **Job Set** for the **Type** option.
2. Set parameters for individual processes within the set as needed. A process set itself doesn't have parameters.
3. Determine the schedule, output, and notifications for the entire process set as you would for any scheduled process.
4. Set any other options and click **Submit**.

### Scheduled Process Options: Examples

When you submit scheduled processes, click the **Process Options** button in the Process Details dialog box to set options such as language and time zone.

These settings:

- Affect the data to be processed, as well as the output template text, if any
- Apply to every run in the schedule, if you're submitting the process to run on a schedule
- Override what's set in general preferences when you click your user name in the global header and go to **Personalization > Set Preferences**

#### Language

You set the language process option to Spanish, while the Current Session field is set to Japanese in your general preferences. The report output template text and report data are displayed in Spanish. If you don't set the language process option, then the report is displayed in Japanese.

#### Currency

You set the currency process option to Euro, while your general currency preference is set to Yen. The scheduled process makes calculations based on the Euro, and the report displays all monetary amounts in Euro.

### Process Set Details: Examples

When you're submitting a process set, the Processes tab in the Process Details dialog box lists all the individual jobs in the job set that the process set is based on. Each job and job set within the job set that you're submitting is considered a step and has a unique step ID.

- The **Path** column shows the step ID of the job, preceded by the step IDs of its parent job sets within the hierarchy, if any.

  **Tip:** You use the path information mainly to differentiate between multiple instances of the same job within a job set.

- The **Job Set** column shows the parent of each job in the hierarchy.
Scenario
You’re submitting a process set based on Job Set A, which contains:
- Job 1 (with a step ID of Step1)
- Job Set B (Step2), which contains:
  - Job 2 (Step2a)
  - Job 1 again (Step2b)

This table shows what the Processes tab displays for this example.

<table>
<thead>
<tr>
<th>Job Definition</th>
<th>Path</th>
<th>Job Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job1</td>
<td>Step1</td>
<td>Job Set A</td>
</tr>
<tr>
<td>Job2</td>
<td>Step2.Step2a</td>
<td>Job Set B</td>
</tr>
<tr>
<td>Job1</td>
<td>Step2.Step2b</td>
<td>Job Set B</td>
</tr>
</tbody>
</table>

Management and Output

Scheduled Process Statuses: Explained

After you submit a scheduled process, it can go through many statuses until it reaches a final state.

The following table explains the possible statuses. The Action Required column indicates that:

- **No (in progress):** The process was submitted and hasn’t yet reached a final state. You or administrators don’t need to do anything to move the process along.
- **Yes:** You or administrators need to do something to get the process to another status.
- **No (final):** The process is done running, and nothing else can be done for the process.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Action Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blocked</td>
<td>At least one other running process is incompatible with and currently blocking your process. The situation will be automatically fixed.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Canceled</td>
<td>The process was canceled. You can’t restart it, but you can resubmit with the same parameters or submit a new process.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Canceling</td>
<td>The process is currently moving to the Canceled status.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
<td>Action Required?</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Completed</td>
<td>The main part of the process completed, and postprocessing (such as sending notifications and generating output) has started.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Error</td>
<td>The process finished running and ended in error.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Error Auto-Retry</td>
<td>The process ended in error but will automatically run again.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Error Manual Recovery</td>
<td>The process ended in error and requires an administrator to retry to move the process to a final state.</td>
<td>Yes</td>
</tr>
<tr>
<td>Expired</td>
<td>The process didn't run before its schedule ended. You can't restart it, but you can resubmit with the same parameters or submit a new process.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Finished</td>
<td>The main part of the process and postprocessing has completed. The process will move on to a final state.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Hold</td>
<td>The process is put on hold and needs someone to release it before it can continue running.</td>
<td>Yes</td>
</tr>
<tr>
<td>Paused</td>
<td>The process is paused so that another process that was automatically invoked can run first.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Pending Validation</td>
<td>Some validations, for example related to security, are performed on the process before it can start running.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Ready</td>
<td>The process passed validation and is about to start running.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Running</td>
<td>The main part of the process is currently running.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Schedule Ended</td>
<td>The process already reached a final state, and its schedule has ended.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Succeeded</td>
<td>The process is completely done, and everything was successful.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Validation Failed</td>
<td>The process failed validation and requires an administrator to resolve the issue.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Managing Scheduled Processes That You Submitted: Points to Consider

After you submit a scheduled process, you can monitor and manage the submission. For example, you can cancel the process while it’s still running, or resubmit it after it’s done. Use the Scheduled Processes work area to perform any of the following tasks. Some of these tasks might be available also on other pages.

Managing Submitted Processes

Follow these steps:

1. Open the Scheduled Processes work area.

   🌐 Tip: Refresh the search results to see the latest status for your process.

2. Select your scheduled process in the table.

3. If the process hasn’t started running yet, you can still use the Actions menu to edit the process’s schedule or output options.

4. If the process is currently running, use the buttons on the table to:
   a. Cancel the submitted process.
      While the process cancellation is still in progress, you can terminate the process by using one of the following options as available in the Actions menu:
      - Force Cancel: To end a process that has been running for over 30 minutes but isn’t canceled yet.
      - Hard Cancel: To end the process shortly after it’s canceled, without waiting for the process to end by itself.
   a. Put the process run on hold.
   a. Release the process so that it's no longer on hold and continues to run.
   a. View the log to get information about how the process is running.

5. If the process is already done, you can:
   a. Click Resubmit to run the same process again.
   a. Use the Details section following the search results to view:
      - Submission notes, the text that you entered when submitting the process
      - Completion notes, which are automatically generated when the process reaches a final state, summarizing how the process completed
      - The log attachment, for example for details about why the process ended in error

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Action Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait</td>
<td>The process passed validation but isn’t able to start running yet, due to system resources.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Warning</td>
<td>The process finished running and ended with a warning, for example, that a notification failed to send.</td>
<td>No (final)</td>
</tr>
</tbody>
</table>
• Report output that the process generated, if any

Viewing Report Output from Scheduled Processes: Procedure

Aside from manipulating records, some scheduled processes also give you report output. When you submit the process, you can select the output layout and format, and set other output options. Use the Scheduled Processes work area to view the output, and optionally republish the output in a different format without resubmitting the process. To view the output on other pages, use the **View Output** column in the table where you monitor submitted processes.

Viewing and Republishing the Output

Follow these steps:

1. Open the Scheduled Processes work area.
2. Refresh the search results, if needed, to see the latest status for the processes.
3. Select your scheduled process in the search results.
4. Go to the Output subsection, at the end of the Details section.
5. Click the link in the **Output Name** column to view or download the output, which you can then print.
6. To view or export the output in a different format:
   a. Click the **Republish** button
   b. Click the **Actions** icon.
   c. Hover on **Export** and select a format.

   **Tip:** Instead of following these steps to get output in the Data format, you can just click the **XML Data** icon next to the **Republish** button.

FAQs for Scheduled Processes

Why are scheduled processes displayed in a hierarchy?

A scheduled process with lower level child nodes might be a process set. The hierarchy represents the structure of processes or process sets within a specific process set.

Or, when a scheduled process runs, it might cause other processes to run automatically, so those processes are displayed one level below the original process.

What's the difference between Hard Cancel and Force Cancel?

Hard Cancel is used to terminate a scheduled process shortly after it's canceled, without waiting for the process to end by itself.

Force Cancel is used to terminate a canceled scheduled process that has been running for over 30 minutes but isn't yet canceled.
Chapter 8
Business Intelligence

Analytics and Reports: Overview

Business intelligence involves analyzing data to gain insight that you can act on, or gathering information to meet specific requirements. You can use different types of predefined analytics and reports, or create and edit them, to support your business needs.

Using Analytics and Reports

This table describes the purpose of analytics and reports.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>An interactive display of data, for example in a table or graph.</td>
<td>To summarize or break down simple, real-time data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To help you make short-term decisions.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>A collection of analyses and other content, presented on one or more pages, or tabs.</td>
<td>To get various pieces of information about a particular subject.</td>
</tr>
<tr>
<td>Report</td>
<td>Output of data in a predefined format that provides little or no interaction.</td>
<td>To get high-volume data in a high-fidelity output optimized for printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For documents to support internal operations, statutory requirements, and other business needs.</td>
</tr>
</tbody>
</table>

Note: You can export tables on UI pages to Microsoft Excel workbooks, where available, and use the exported data for analytical purposes.

For more information on using analytics and reports, see the Using Analytics and Reports guides for your products.

Creating and Editing Analytics and Reports

You can create and edit analytics and reports for your own use. Or, if you have the appropriate roles, you can make changes to objects for others.

For example, you can:
- Add or remove columns from an analysis.
- Change the branding logo on report output.
- Create a dashboard to include your most commonly viewed analyses.
For more information on creating and editing analytics and reports, see the Creating and Editing Analytics and Reports guides for your products.

Related Topics
- How can I find analytics and reports?
- Reports and Analytics Work Area and Panel Tab: Explained

Viewing Analytics and Reports

Video

Watch: This video tutorial shows you how to find analytics and reports, and how to make the most of the viewing features. The content of this video is also covered in text topics.

Procedure

You can view analyses, dashboards, and reports on the pages and infolets you usually work with, or navigate directly to them in the business intelligence catalog using the Reports and Analytics work area and the Reports and Analytics panel tab. You can also view analytics in infolets.

Viewing Analytics in Infolets

To view analytics in infolet pages you usually work with:

1. Explore frequently used infolet pages using the page controls and Previous and Next icons.
2. You may find analytics displayed in infolets with summaries and aggregations or performance metrics.
3. Click the infolet to open a detailed report, for example to view the details of transactions that are aggregated as a total.
4. Click Done to return to the infolet page.

Viewing Objects in Familiar Work Areas and Pages

To view analyses, dashboards, and reports on the pages and work areas you usually work with:

1. Explore frequently used pages, where you may find one or more analyses and reports available as links or embedded in parts of the page, including tabs or panel tabs.
2. Some work areas have a Reports and Analytics panel tab, in which you can explore the catalog folders for analyses and reports specific to the work area and, if you have permission, map additional objects to the work area.
   a. Open the panel tab.
   b. Expand the Shared Reports and Analytics folder and explore the available content.
   c. Click the link for any object and see its type to determine whether it’s an analysis, a report, or a dashboard.
   d. To view the object, click View.
Viewing Objects in the Reports and Analytics Work Area

To search or browse the catalog and view any analysis, dashboard, and report you have access to:

1. Click **Navigator > Reports and Analytics**.
2. Filter and search for objects:
   a. Optionally, select from the filter list to refine results by object type.
   b. Enter a name or partial name and click **Search**. To view objects you have marked as favorites, select **Favorites** in the list. Select **Recent Items** to view objects you have recently worked with, or a recent search to run it again.
   c. In the search results, use the icons to identify the type of the objects.
   d. Locate an analysis, dashboard, or report and select it, then click **More** and select **View**.
3. In the catalog breadcrumb, you can also browse the catalog folders for analytics and reports.
   a. Click the **Hierarchical Selector** for All Folders and click **My Folders** or **Shared Folders** to explore their subfolders or contents to locate objects.
   b. Click **More** for an object, and then select **View** to open it, or **Edit** to modify it.

Viewing Analyses

An analysis queries against your company’s data and gives you answers to your business questions. Analyses are visualizations, such as charts and tables, of a specific set of data, and may appear in your frequently used pages, or as components of a dashboard.

To view analyses:

1. From the catalog folders or search results, open an analysis to view.
2. Click **Refresh** to rerun the analysis and refresh its data.
3. Click **Print** and select either Printable PDF or Printable HTML to open a printable version of the analysis.
4. Click **Export** to export analysis data in various formats, for example PDF, Excel, PowerPoint, and XML.

Viewing Dashboards

Dashboards are a collection of analyses grouped together to return data. A dashboard contains analyses, prompts which filter information, and other objects that are presented on one or more pages.

To view dashboards:

1. From the catalog folders or search results, open a dashboard to view.
2. If available, select values for dashboard prompts to filter the dashboard.
3. Click **Apply** to refine the results of all of the analyses in the dashboard.

Viewing Reports

Reports show data in a predefined format that’s optimized for printing.

To view reports:

1. From the catalog folders or search results, click a report’s name to view it.
2. Click the **View Report** icon.
   - Choose whether you want the report displayed as HTML or PDF for printing. Because it’s optimized for printing, often PDF provides the best print results.
   - You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.
3. From the catalog folders or search results, you can also:
   - Click **Edit** to edit the report properties, layout, and data model.
   - Click **Report History** to view details about when the report was submitted in the past.
   - Click **Schedule** to schedule the report to be run.

**Using and Creating Analytics and Reports: Highlights**

The Reports and Analytics pane is a central place for you to quickly view or run analytics or reports relevant to your work. The pane is available in many work areas and contains links to analytics and reports specific to the work area. You can also select **Navigator > Tools > Reports and Analytics** to open the Reports and Analytics work area, which contains links to all the analytics and reports that you have access to.

The Reports and Analytics pane has a Shared Folders area and may also contain a My Folders area if you saved any personal reports or analytics. Each area has a hierarchy of folders that may contain these types of items:

- **Analysis**: Graph or table that displays specific sets of data
- **Dashboard**: One or more pages containing multiple analyses
- **Report**: Data in a predefined, printable format, often registered as a scheduled process so you can submit and monitor the report as you would any process

**Using and Creating**

In the Reports and Analytics pane:

- Open the folders and click the item that you want to use.
- Click Create to create reports and analyses.
- Click Browse Catalog on the toolbar (or the More link for a specific report, dashboard, or analysis) to use additional features.

**Resources**

- In the Oracle Help Center, review videos, guides, and other resources for using and creating analytics and reports.
  - **ERP**
    - See: Financials Reports and Analytics
    - See: Procurement Reports and Analytics
    - See: Project Portfolio Management Reports and Analytics
  - **HCM**
    - See: Human Capital Management Reports and Analytics
    - See: Talent Reports and Analytics
  - **Sales**
    - See: Sales Reports and Analytics
SCM

See: Supply Chain Management Reports and Analytics

- For lists of predefined reports and analytics, see the Analyze and Report page for your cloud services in the Oracle Help Center (http://docs.oracle.com).

Related Topics

- Creating and Editing Analytics: Highlights
- Creating and Editing Reports: Explained
- Saving Analytics and Reports: Points to Consider
- Oracle Help Center
9 Personalization

Page Personalization

How can I retain minor personalizations after I sign out?

Whether minor personalizations (such as changing table layout and hiding regions) persist after you sign out, depends on the page you’re on. However, to retain all minor personalizations, make changes by clicking your user name in the global header and selecting Personalization > Edit Current Page (if available).

Related Topics

- Saving Searches for Searches with Multiple Criteria: Procedure

How can I restore a page to the default content and layout?

Click your user image or name in the global header and select Personalization > Reset to Default Content and Layout (if available for the page you’re on).

What happens if I restore a page to the default content and layout?

You remove all changes that you had previously made to the page using Personalization > Edit Current Page. The reset affects objects at the page level, for example, dashboard regions that you added or moved around, and dashboard layout changes. Restoring doesn’t reset personalization changes made within the components of a page, for example, within a dashboard region.

Springboard Personalization

How can I personalize the springboard content?

Use the Personalize Springboard page to personalize the content of the springboard. Click the Personalize Springboard icon on the home page, and select the groups and page entries that you want to display on the springboard. You can only personalize the content of the springboard, not that of the Navigator menu.

How can I restore the springboard to the default content?

Click Reset to Default on the Personalize Springboard page to remove all changes that you had previously made to the springboard content using the same page.
What happens if I restore the springboard to the default content?

You remove all changes that you had previously done to the visibility settings of the groups and page entries, and reset them to the default settings.

Personalizing Infolets: Procedure

Use infolets to aggregate key information for a specific area, for example, social networking or your personal profile. You can use the page control on the home page to open infolets and view important information at a glance.

Note: If the infolet icons aren’t available on the home page, administrators can enable infolets using the Home Configuration page of the Structure work area.

You can:

- Edit infolet titles and views.
- Move infolets.
- Hide or show specific infolets on an infolet page.

Editing Infolet Titles and Views

Follow these steps:

1. Click the Actions icon on the top right corner of the infolet, and select Edit Title and Views.
2. Edit the infolet title, and enable or disable the infolet views.
3. Click Save and Close.

Moving Infolets

To change the position of an infolet within an Infolet page, click and drag the infolet, and drop it at the required position.

Hiding and Showing Infolets

To hide an infolet from an infolet page, click the Infolet Repository icon, and deselect the infolet from the list of infolets.

Tip: Alternatively, click the Actions icon on the top right corner of the infolet, and select Hide.

To show a hidden infolet on an infolet page, click the Infolet Repository icon, and select the infolet from the list of infolets.

Related Topics

- Configuring Home Page Navigation: Procedure
- Why is the icon for my infolet page not available in the page control on the home page?
10 Preferences

How can I set general preferences for myself?

Use the General Preferences section in the Set Preferences work area to set your general preferences. Click Navigator > Set Preferences. You can set the general preferences such as language, currency, time zone, accessibility and watchlist.

Related Topics
- How can I set general preferences for all users?

What's the display name language preference?

It’s the setting that displays all person names including your own name in the global header, in a specific language. For example, if your display name language is Spanish and your name is Alexander, then you see your name as Alejandro.

If the equivalent of a name doesn’t exist in the preferred display language, or if the display language is not set, then the user names are displayed in the preferred default language.

Uploading My Photo: Procedure

You can upload your photo using the My Details page in the Personal Information work area. When you upload your photo, you can view it in your public information page, Directory search results, and the global header. You can have only one profile photo at a time.

You can also update your photo using the My Photo page in general preferences. Click your user image or name in the global header and go to Personalization - Set Preferences - My Photo.

Uploading a Photo

To upload or update your photo:

1. In the Personal Information work area, click Update Photo (camera icon) in the user image or name, or the My Photo page in general preferences. The Update Photo icon appears when you hover over your image or name.
2. Click Browse to select and upload photo.
3. When uploading the photo,
   - Ensure that the file size is less than 2 megabytes.
   - Upload a photo in any format, but the typical format is either a .png or .jpeg file
   - Ensure that the photo dimensions are 90 x 120 pixels to help reduce the distortion of photo. If the photo is not 90 x 120 pixels, it’s recommended to maintain a 3 x 4 aspect ratio.
4. Click Save and Close.
Setting Up the Accessibility Modes: Procedure

You can enable the accessibility mode in the Accessibility Preferences page. Follow these steps to enable the accessibility mode:

1. In the global header, click the Accessibility icon.
2. If you rely on screen reader assistive technologies, switch to the Screen Reader mode. Selecting this mode changes several aspects of the user interface. For example, a tree component has an additional column which you can use to select specific tree nodes.
3. Select the additional options according to your preference:
   - If you run your operating system in a high contrast mode such as black on white then switch the color contrast to High.
   - If you run your operating system in a font size greater than 100% of normal size then switch the font size to Large.
4. Click Save.

Related Topics
- Accessibility Features: Explained
- Accessibility in the Application: Overview
- Managing Themes: Procedure

How can I change or reset my password?

Use the Preferences page to change your password.

In the global header, click your user image or name and select Set Preferences in the Settings and Actions menu. In the General Preferences section, click Password.

Proxies

Proxies: Explained

You can designate another user as a proxy to sign in to the application and perform tasks on your behalf. Proxies are helpful when you can’t perform the tasks in person during a specific period.
In the global header, click your name, and from the Settings and Actions menu, select Set Preferences. On the Preferences page, click Proxies.

Impersonation
When your proxies sign in to the application on your behalf, they would be working in an impersonation session. During that period, your proxies have unrestricted access to your account, except that they can’t change your preferences. The application supports a scenario where you and your designated proxies can sign in at the same time.
When you sign in, you would see all the work your proxies did on your behalf.

Security
You don’t need to share your password with your proxies. While signing in to your account, your proxies must enter their password to verify their identity.

Related Topics
- How can I perform tasks on behalf of another user?

Why can't I find a specific person to set as my proxy?
The user must have a role with the appropriate privilege FND_IMPERSONATE_USER_PRIV. Otherwise, the user doesn’t appear in the search results on the Proxies page.

Note: This functionality is currently not available for Oracle HCM Cloud users.

Watchlist

Displaying and Hiding Watchlist Items: Procedure
Use your Watchlist preferences to show or hide specific items or categories in your Watchlist.
The preferences contain:
- All the predefined Watchlist categories and items available to you
- Any saved searches you’re using as Watchlist items

Setting Watchlist Preferences
Follow these steps:
1. Click your user name or image in the global header, and go to Personalization > Set Preferences > Watchlist.
2. Use the Enabled check box to display or hide any Watchlist item or category.

Note: Disabling a category automatically hides all of its items.

Note: This functionality is currently not available for Oracle HCM Cloud users.
3. Optionally hide enabled Watchlist items that show no records.

Related Topics

- Why are some items not displayed in my Watchlist?
- How can I rename Watchlist items?
- Creating Watchlist Items: Procedure
- Why is the count different between a Watchlist item and the page that the item link takes me to?

Why are some items not displayed in my Watchlist?

Items might be hidden based on your Watchlist preferences. These preferences also apply to saved searches that you're using as Watchlist items. To review your preferences, select your user name or image in the global header, and go to `Personalization > Set Preferences > Watchlist`.

Other possibilities could be that:

- You deselected saved searches in the Manage Watchlist dialog box, so they're no longer used as Watchlist items.
- You deleted saved searches that were used as Watchlist items.
- Your administrator disabled specific predefined Watchlist items or categories for all users.
- Your administrator disabled using saved searches (from specific pages) as Watchlist items.
- Your administrator revoked access to tasks or pages that used to be available to you.

In these cases, you can no longer see the corresponding Watchlist items in your Watchlist and in your Watchlist preferences.

Related Topics

- Displaying and Hiding Watchlist Items: Procedure
- Creating Watchlist Items: Procedure
11 Help

Using Applications Help

Video

Watch: This video tutorial shows you how to find help and make the most of the help features. The content of this video is also covered in text topics.

Procedure

Find help in the Applications Help site, or from help windows that are available on many of the pages you use. To open Applications Help at any time, click your user image or name in the global header and select Applications Help.

Using Help Windows

Use help icons on the page to open help windows that give you information about the whole page or part of the page. The window can contain informational text, links to help content, or both.

1. If you don’t see help icons, click the Show Help icon in the global header to display them on all pages where available.
2. Click a help icon. If the icon isn’t next to the page title, then the help window contains information specific to the part of the page you’re on.
3. On the help window, click the link of a title, if any are available, to see a summary of the corresponding help content. If the help is a video, then the video plays automatically in the window.
4. Click the More link at the end of the summary to see the full help content.
5. Click More Help at the bottom of the help window to open Applications Help. You land on search results showing help that’s related to what you’re working on.

Searching and Browsing in Applications Help

In Applications Help, you can set the scope of your search.

- Use the Applications Help home page to search across all help content. To return to the home page at any time, click Home in the global header.
- Use the springboard or filmstrip in Applications Help to open landing pages for specific product families. Use the search on those pages to find help relevant to the product family.

Tip: Put quotation marks around what you enter in the search field, to search on the exact phrase.

Use the landing pages to browse for help relevant to the product family. For example, you can find:

- Getting Started: Information that’s helpful to new users
- Role: Help that’s specific to the roles you have
- Learning Resources: Guides and other materials on Oracle websites
Filtering Your Search Results
To narrow your results in Applications Help, use filters such as Task, Product, Help Type, or Role. For example, use the Help Type filter to see only videos, or the Role filter to see only what’s relevant to you as an employee. If your organization has added help to the help site, then the Source filter is available for you to focus on just those files.

Help Types: Explained
Applications Help has many types of help content: examples, FAQs, glossary terms, help topics, PDF guides, and videos.

Example
Examples can provide:
- Real use cases to illustrate how and when to do something
- Scenarios to explain abstract concepts

Worked examples show exactly what you do to achieve a specific result. They emphasize decisions that you make and values that you enter.

FAQ
FAQs, or frequently asked questions, provide brief answers to questions that you might have about a task or page. For example, they can explain:
- What a term means
- Why something happened
- How you can perform an action
- What happens if you perform the action

Glossary Term
Glossary terms provide definitions for words or phrases used in help content. In a help file, terms that have glossary definitions are presented as links. When you see terms underlined with dots, you can hover over the term to see its definition. To see the whole glossary, select Glossary from the Navigator menu in Applications Help.

Help Topic
Help topics can:
- Explain key concepts
- Tell you the steps to follow to perform tasks
- Help you make decisions by explaining points to consider or describing the options you have
- Show you how application components work together
- Provide reference, overview, and other information
PDF Guide
PDF guides provide information in a book format. The guides in Applications Help contain content that you usually can’t find in other help types.

Note: Most of the examples, FAQs, and help topics in Applications Help are also in guides. To see these guides, select Documentation Library from the Navigator menu in Applications Help.

Video
Videos, or tutorials, show you how to complete a short task or part of a task. Videos can also give you an overview of complex dashboards and work areas.

Using the Oracle Help Center

Video

Watch: This video tutorial shows you how to find guides, videos, release readiness content, and other resources for SaaS applications in Oracle Cloud. The content of this video is also covered in text topics.

Procedure
The Oracle Help Center (https://docs.oracle.com) contains guides, videos, release content, and other resources for Oracle Applications Cloud. You can use the URL to open the Oracle Help Center home page, or get to the Help Center from Applications Help.

Navigating in the Help Center
To find guides and other materials for a specific cloud service:

1. On the Oracle Help Center home page, click Cloud. You can also open the Cloud Documentation page from Applications Help by clicking Navigator > Documentation Library, if the menu item is available based on setup.
2. In the Get Started with Oracle Cloud Services section on the Cloud Documentation page, click Software as a Service.
3. Click the name of your cloud service. You can also open the cloud service page from Applications Help:
   a. On the Applications Help home page or filmstrip, click the icon for your cloud service.
   b. On the landing page for the cloud service, in the Learning Resources panel, click links that contain Documentation.
4. Select a release for the cloud service, as needed.
5. To navigate to a specific guide, video, or other resource, you can:
   o Browse for information on the cloud service page. For example, in the:
     • What's New panel: Learn about new features and other changes for the release.
• **Tasks section in the navigation pane:** Click a task category and then a specific task, to open the guide that covers the task.

• **REST API section in the navigation pane:** Get reference information about REST APIs, if available.
  o Click the Videos or Books link in the navigation pane to get all the videos or guides for the cloud service.

6. When you have a guide open, use the links on the Table of Contents tab to navigate to other parts of the guide.

💡 **Tip:** Use the breadcrumbs that are available on most Help Center pages, or available when you have a guide open, to navigate to other parts of the Help Center.

### Searching in the Help Center

The scope of the search depends on where you’re at in the Oracle Help Center. For example, on the Cloud Documentation page, you search across all cloud services in Oracle. On the pages for a specific cloud service, you search only within that service.

To search within a guide:

1. Open any HTML page within the guide.
2. Open the Search tab.
3. With the **Search this book** option selected, enter your keywords and run the search.
4. In the new browser tab containing the search results, click one of the two links available for your desired search result.
   o The first link takes you to the beginning of the relevant chapter.
   o The second link takes you directly to the part of the chapter that contains the summary text displayed in the search result.

### Related Topics

- Oracle Help Center

### FAQs for Help

#### How can I find help for my country and language?

In Applications Help, use the Language and Country filters in the search results.

- Select both **American English** and your language to see all help, because not all help is translated.
- Select both **Generic** and your country to see all help for that country.
12 Troubleshooting

Troubleshooting Issues: Procedure

When you run into issues that you can’t easily fix yourself, you can follow a general process to troubleshoot the issue. This process can involve error messages, diagnostic tests, recordings of the issue, and your help desk.

General Process

Follow these steps:

1. If you get an error message, especially for a system or application error, the message might say that your help desk was notified. If so, then an incident is automatically created and sent to your help desk. Or, the message might advise you to contact the help desk yourself. Either way, note down the message ID that appears after the message text, and the incident ID (if any).
2. Run diagnostic tests if you have access to do so and can find tests relevant to your issue. Click your user image or name in the global header and select Run Diagnostic Tests under Troubleshooting. If you can’t run diagnostic tests, or can’t resolve the issue after looking at test results, then go to the next step.
3. Contact your help desk and provide the IDs you noted in step 1, any diagnostic test results, and anything else related to your issue.
4. If your help desk asks you to reproduce and record your issue, then click your user image or name in the global header and select Record Issue under Troubleshooting.
5. After you finish recording, note down all the information about your recording (for example the recording ID) and send it to your help desk.
6. Continue working with your help desk to resolve your issue.

Diagnostic Tests

Diagnostic Tests: Highlights

Use diagnostic tests to identify and resolve issues. To open the Diagnostic dashboard, click your user image or name in the global header and go to Troubleshooting > Run Diagnostic Tests. If you don’t see this menu item, then your help desk can make it available to you.

The Oracle Fusion Applications Administrator’s Guide fully describes using and managing diagnostic tests. As you read content from that guide, you can ignore discussions about the command line interface because selecting Run Diagnostic Tests doesn’t take you there. To get a list of predefined diagnostic tests, or information about a specific test, browse Applications Help or contact your help desk.

Finding and Running Diagnostic Tests

- Predefined diagnostic tests are assigned a tag name and value to help categorize them. You can browse and find tests using tags.
- Your roles determine what you do, for example, whether you can just view or also run diagnostic tests.
Reviewing Diagnostic Tests

After you run a diagnostic test, you can perform other tasks for the tests you submitted. Your roles determine if you can perform any of these tasks on diagnostic tests that others submitted.

- Check the status of the diagnostic test run itself, or see if certain diagnostic tests have detected problems.
  See: Using the Diagnostic Dashboard Application to Check the Status of a Diagnostic Test
- Cancel a test that’s currently running.
  See: Canceling Diagnostic Test Runs
- Review diagnostic test results.
  See: Using the Diagnostic Dashboard Application to View the Results of Diagnostic Tests
  - If you have the roles that allow you to do so, optionally add the test result information to an existing incident.

Diagnostic Tests: Examples

When you encounter an issue, you can try to diagnose it yourself by running diagnostic tests, before following up with your help desk. You can also use diagnostic tests to take preventive measures and identify potential issues before running into real problems.

Note: You can run diagnostic tests only if you have roles that let you do so.

Health Check

This example shows running a diagnostic test to verify that data is correct before starting a large-volume task.

1. You are a general ledger manager, and you periodically run diagnostic tests to check on data, setup, and configurations, especially before closing the period.
2. You open the Diagnostic dashboard and run the General Ledger Misclassified Accounts Validations test, to make sure that all accounts are correctly classified.
3. You review the test results and confirm that the accounts are ready for the period close process.

Troubleshooting

This example shows running a diagnostic test to start the troubleshooting process.

1. You are a general ledger manager, and you run into issues with the period close process.
2. You open the Diagnostic dashboard and search for diagnostic tests using tags, with Financial Control and Reporting as the tag name.
3. You browse the search results for tests with Close Ledgers as the tag value.
4. You find and run the appropriate test, General Ledger Closing Validations.
5. The diagnostic test results can show issues that you can’t fix yourself: validation errors in setup, configuration, or data integrity. In this case, it’s incomplete accounting setup.
6. You notify your help desk about the diagnostic test results and describe your issue.
   - If the test results had shown issues that you can’t fix yourself, but didn’t have validation errors, then you would ask your help desk to create an incident. The help desk would take over in the troubleshooting process.
7. Your help desk performs a fix and asks you to rerun the test.
8. You repeat steps 4 through 7 until the test completes with no issues identified.

Data Analysis
This example shows running a diagnostic test to collect data for analysis.

1. You are a purchasing buyer, and you notice unexpected data in a specific purchasing document.
2. You search in Applications Help for information related to purchasing documents, to see if you can find any relevant troubleshooting information. You find a list of predefined diagnostic tests, and you check if there is a relevant diagnostic test.
3. You open the Diagnostic dashboard and run the appropriate test, Manage Purchasing Documents Lifecycle - Validate.
4. You review the test results, which give you all the details about the particular purchasing document.
5. You see the reason for the unexpected data and resolve the issue yourself.

Application User Session Run Time Diagnostic Test
Use the Application User Session Run Time diagnostic test to analyze a user’s session. A session starts when users signs in and ends when they sign out.

Run this test from the Diagnostic dashboard. Click your user image or name in the global header and go to Troubleshooting > Run Diagnostic Tests.

Application User Session Cookie
Enter the cookie to identify the user session that you want to analyze.

To get the session cookie value:

1. Run the Application User Session Configuration diagnostic test to make sure that the ApplSession configuration values for your application are correct.
2. Use a valid user name and password to sign in.
3. Display the list of cookies in your browser, according to instructions for the browser.
4. In the cookies listed for your domain site, select the cookie named ORA_FND_SESSION_<DATABASE_SID>.
   - Your domain site is the host in the URL, for example oracle.com in the URL http://example.us.oracle.com.
   - <DATABASE_SID> is your database session ID.

If you can’t locate the cookie, then no application user session has been created for your application.

5. See the Content field, which has the format pillar_name:session_cookie_value:timestamp. For the Application User Session Cookie parameter, enter the session_cookie_value part, which appears between two colons.

Recording Issues to Troubleshoot: Procedure
To help your help desk troubleshoot issues that you encounter in the application, you can record the issue while you reproduce it. Not only would the recording show your help desk what happened, but it also collects detailed data that your help desk can analyze. You can also attach additional notes and material, such as screenshots, to most recordings.
Creating a Recording

Follow these steps:

1. Open the page where your issue occurred. If the issue is that a page isn't opening or displaying properly, then you can be on any page to start the recording before you try to open the problematic page again.
2. Click your user image or name in the global header and go to Troubleshooting > Record Issue. If you don’t see this menu item, then contact your help desk or security administrator.
3. For most issues, choose to collect page diagnostics while you’re recording. Collect performance statistics only if the issue is that the application is working too slowly.
4. Open the Advanced Options section (if you’re given access) and set the recording time according to your help desk or for as long as you think it would take to reproduce your issue. You can always stop the recording as soon as you’re done.
   If you’re collecting page diagnostics, you can take screenshots while you record and attach them to your recording later. So take into account the time that it takes to capture screenshots.
5. If your help desk asks you to enter other advanced options, then fill out the rest of the section based on what your help desk tells you.
6. Click Start Recording to record on the current page, or on the next page that you open immediately after you click the button.
   If you open yet another page after that, then the recording will automatically stop.
7. Click Stop Recording or record until the allotted time runs out.
8. If you’re collecting page diagnostics, optionally add notes and attach screenshots or other relevant files to the recording.
9. Note down your recording ID, and click Submit.

   Tip: You can later open the Record Issue dialog box again and click View My Recordings to find the ID and other information about this recording.

FAQs for Troubleshooting

What's an incident?

An incident is a collection of diagnostic information for a critical application error. This information shows the state of the application at the time the problem occurred.

If you get an error message for an issue severe enough to prevent you from continuing your work, then an incident is automatically created and forwarded to your help desk. Any diagnostic tests associated with the error message would also run automatically, with the results added to the incident. Your help desk can also manually create incidents.

How can I find information about specific issue recordings?

After you record an issue, you get a confirmation with the recording ID and other information to identify your recording. To find this same information later:

1. Click your user image or name in the global header and go to Troubleshooting > Record Issue.
2. Click the View My Recordings button.

What's the difference between the recording ID and the recording number?

The recording ID is the unique identifier for your recording of an issue. Use the ID to find your recording later, for example from a list of recordings.

The recording is stored on a server, and the recording number identifies it on the server. To get the actual recording files from the server, your help desk needs the recording number and server information.

How can I view the version information of an application?

In the global header, click your user image or name and from the Settings and Actions menu, select About This Page. The basic details about the application are visible by default. However, you must have appropriate roles to view the version and release information, and other important details about the application.
13  Accessibility

Accessibility in the Application: Overview

Oracle Fusion Applications is designed with accessibility features that support assistive technologies, such as screen readers. You can set accessibility preferences to use the application in accessibility mode. For more information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/us/corporate/accessibility/index.html

Keyboard Shortcuts

You can navigate the entire application without a mouse and access all relevant functionality using only the keyboard. You don't need assistive technology to use keyboard-only navigation, which is available to all users. Keyboard shortcuts enable you to perform user interface actions without using a mouse. For example, you can use keyboard shortcuts to save a file or open a tab. Keyboard shortcuts for specific UI elements come from the Oracle Application Development Framework components that they're based on. You might also find keyboard shortcuts that are specific to a particular feature or product.

Related Topics

- Oracle's Accessibility Program

Accessibility Features: Explained

You can use assistive technology products, such as screen readers, while you work in the application. In screen reader mode, certain components render differently. For example, date fields in the default mode have a date picker. You can either use the date picker to choose a date, or manually enter the date as text. In screen reader mode, you only enter information as text because date pickers aren't available.

You can also use the keyboard instead of the mouse. Some of the accessibility features discussed here are:

- Skip navigation links
- Additional role and state labels
- Isolated display
- Content change announcements
- Alternatives to drag and drop

Skip Navigation Links

When you access a page and press Tab, the Skip to main content link appears. Use this link to skip the global header and navigate directly to the filmstrip, which is the row of page entry icons above a page.
Additional Role and State Labels
When you access a page in screen reader mode, the screen reader reads the labels of various user interface components such as menus and regional or local area panes, including the role and state labels. These additional labels provide information about the purpose and current state of the item. In some cases, the Web Accessibility Initiative - Accessible Rich Internet Applications (WAI-ARIA) standards are leveraged for role and state information.

Isolated Display
In screen reader mode, when you open a menu or a dialog box, the display is isolated on the open component until you close it. Also, the isolated dialog boxes identify UI elements with issues, such as fields with invalid data entry.

Content Change Announcements
In screen reader mode, WAI-ARIA live regions announce changes to the application. For example, when you open or close dialog boxes, you can hear the rendering of partial content, progression of progress indicators, or changes in the menu and dialog box state.

Alternatives to Drag and Drop
Pages that provide drag and drop operations also support alternative methods of operation.

In tables where you can use drag and drop to move or resize columns, you can alternatively use the following features:

- From the View menu, select Reorder Columns and move(or change) the order of the selected items.
- From the Format menu, select Resize Columns and resize the selected items.

Related Topics
- Setting Up the Accessibility Modes: Procedure

Setting Up the Accessibility Modes: Procedure
You can enable the accessibility mode in the Accessibility Preferences page. Follow these steps to enable the accessibility mode:

1. In the global header, click the Accessibility icon.
2. If you rely on screen reader assistive technologies, switch to the Screen Reader mode. Selecting this mode changes several aspects of the user interface. For example, a tree component has an additional column which you can use to select specific tree nodes.
3. Select the additional options according to your preference:
   - If you run your operating system in a high contrast mode such as black on white then switch the color contrast to High.

**Note:** The high contrast works well when applied on any of the accessible themes. The available accessible themes are, Autumn Red, Bright Blue, Crisp Green, Crisp Green Banner, Dark Gray, Dusty Blue Banner, Light Blue, Midnight Blue, Sky Blue, Sky Blue Banner, Steel Gray, Turquoise, and Vanilla.
If you run your operating system in a font size greater than 100% of normal size then switch the font size to Large.

4. Click Save.

**Related Topics**

- Managing Themes: Procedure

---

## Keyboard Shortcuts

### Keyboard Shortcuts for Oracle Application Development Framework Components: Highlights

The application is based on Oracle Application Development Framework (ADF) components which come with standard keyboard shortcuts. In some cases, you might find different keyboard shortcuts specific to the page, feature or product that you're using.

Oracle ADF keyboard shortcuts are described in the Oracle Fusion Middleware Web User Interface Developer’s Guide for Oracle Application Development Framework.

#### Default Mode

- Refer to the following sections in the guide for the corresponding keyboard shortcuts.

  See: Keyboard Shortcuts

  - Shortcut Keys for Common Components
  - Shortcut Keys for Widgets
  - Shortcut Keys for Rich Text Editor Component
  - Shortcut Keys for Table, Tree, and Tree Table Components
  - Shortcut Keys for ADF Data Visualization Components
  - Shortcut Keys for Calendar Component

#### Screen Reader Mode

The keyboard shortcuts for some components in screen reader mode are different from the shortcuts in default mode.

- Refer to the following sections in the guide for the corresponding keyboard shortcuts.

  See: Keyboard Shortcuts

  - Shortcut Keys for Table, Tree, and Tree Table Components in Screen Reader Mode
  - Shortcut Keys for ADF Data Visualization Components in Screen Reader Mode
  - Shortcut Keys for Calendar Component in Screen Reader Mode
Keyboard Shortcuts for Infolets: Explained

You can use keyboard shortcuts to operate the infolets on the home page or specific work areas. The shortcuts might be different from the ones listed in the following table depending on the selected infolet.

This table lists the keyboard shortcuts for infolets.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move focus backward among the components in the page</td>
<td>Shift + Tab</td>
</tr>
<tr>
<td>Open a context menu where available within a template in the page</td>
<td>Alt + Arrow Down</td>
</tr>
<tr>
<td>Open the different components in a chart</td>
<td>Ctrl + Arrow</td>
</tr>
<tr>
<td>Select and deselect the check box in My Infolets</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Open links except those in charts</td>
<td>Enter</td>
</tr>
<tr>
<td>Open links in the templates with charts</td>
<td>Arrow</td>
</tr>
<tr>
<td>Close dialog box</td>
<td>Esc</td>
</tr>
</tbody>
</table>

Related Topics

- Setting Up the Accessibility Modes: Procedure
Glossary

**action**
The kind of access, such as view or edit, named in a security policy.

**analysis**
A selection of data displayed in one or more views, such as a table or chart, to provide answers to business questions.

**analytics**
Business intelligence objects such as analyses and dashboards that provide meaningful data to help with decision making.

**autosuggest**
Suggestions that automatically appear for a search field, even before you finish typing your search term. You can select any of the suggestions to run your search.

**business intelligence catalog**
The repository where all business intelligence objects, including analyses, reports, briefing books, and agents, are stored. The catalog contains separate folders for personal, shared, and modified objects.

**business object**
A resource in an enterprise database, such as an invoice or purchase order.

**dashboard**
A collection of analyses and other content, presented on one or more pages to help users achieve specific business goals. Each page is a separate tab within the dashboard.

**dashboard**
A page that provides quick access to key tasks and summary information for various objects within a functional area of interest.
filmstrip
The single strip of icons above a page that you can use to open other pages.

global header
The uppermost region in the user interface that remains the same no matter which page you’re on.

global search
The search in the global header that lets you search across many business objects.

incident
A collection of diagnostic information about a critical error, providing details about the state of the application when the issue occurred.

infolet
A small, interactive widget on the home page that provides key information and actions for a specific area, for example social networking or your personal profile. Each infolet can have multiple views.

Navigator
The menu in the global header that you can use to open the work areas and dashboards that you have access to.

offering
A comprehensive grouping of business functions, such as Sales or Product Management, that is delivered as a unit to support one or more business processes.

panel tab
A tab that provides supplemental information or functionality for the page. Each panel tab is on the right side of the page, has an icon as the tab label, and slides out when you open the tab.

personalization
A change that users make to control the look or behavior of the application. Personalizations impact only the user making the change.
privilege
A grant of access to functions and data; a single, real world action on a single business object.

process set
A scheduled process that contains multiple individual processes or other process sets.

Query By Example
The row of fields directly above table column headers, used for filtering the data in the table.

regional area
The collapsible region in the work area that lets you control what's in the local area, for example by selecting a task or running a search.

report
An output of select data in a predefined format that's optimized for printing.

role
Controls access to application functions and data.

scheduled process
A program that you run to process data and, in some cases, generate output as a report.

springboard
The grid of icons on the home page that you can use to open pages.

work area
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.

workflow
An automated process that passes a task from one user (or group of users) to another to view or act on. The task is routed in a logical sequence to achieve an end result.